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Introducing Workshare Compare

Chapter 1. Introducing Workshare
Compare

This chapter introduces Workshare Compare, providing an overview of how it works as
well as a summary of the key features and benefits. It includes the following sections:

What is Workshare Compare?, page 9, introduces Workshare Compare.

Workshare Compare Functionality, page 10, describes the different areas of
functionality of Compare.

Accessing Compare Functionality, page 12, describes how to access
Compare functionality after install.

Licensing, page 15, describes how to license Compare after install.
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What is Workshare Compare?

Workshare Compare reimagines multi-party review and collaboration and ensures the
safe and accurate exchange of information, enabling the collaborative evolution of high
value business documents.

Workshare Compare is a desktop application that automates managing changes to
business documents.

Key features of Workshare Compare include:

e Comparison of Word, PowerPoint and PDF files, including image-based PDF
files

e Ability to accept/reject changes in a comparison and then create new documents

e Advanced comparison features for Word and PDF files including one-to-many
comparisons, version comparisons, and access from within Word and
PowerPoint

e Conversion from PDF to DOC format for local files and from within the
DMS/CRM

e Options to save and share Office documents to Workshare online
e Access and visibility into online collaborative workspaces directly from Office

e Secure file sharing from all devices and browsers with metadata removal and
end-to-end encryption

e ECM/DMS and OCR integration with desktop comparison features
e Centralized user account management and control

o Complete access to Workshare online functionality to share and collaborate on
documents, including setting folder access and permissions, positional
commenting and reviewer communications with presence indicators

e Desktop sync app to synchronize your online content to your local desktop

Note: Workshare Compare can be installed without Microsoft Office integration. In
this case, the comparison functionality is only available from the Workshare Compare
application.
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Workshare Compare Functionality

Workshare Compare provides sophisticated functionality that is convenient and
accessible, enabling users to move smoothly between tasks and work rapidly to
manage changes. Workshare Compare assists you throughout the complete document
lifecycle — from document assembly, review, verification and security. Workshare
Compare has also made key functionality of the DMS available, for example, enabling
the comparison of DMS versions.

Workshare Compare may include the Connect product to extend its functionality to
Workshare online.

What can Compare do?

Workshare Compare reinvents multi-party review by helping users understand,
communicate and implement changes more quickly and accurately. Compare shows
precise changes between versions of Word, PDF and PowerPoint files including DMS
files and versions. The DeltaView Redline sets the standard for an easy-to-read,
accurate view of changes between document versions. Compare’s advanced
comparison engine performs comparisons accurately and seamlessly enabling users to
quickly compare even the most difficult and complex documents and presentations.

See the changes

With Microsoft Word and PDF files, users can perform one-to-one and one-to many
comparisons and see accurate DeltaView Redlines in individual tabs. Compare
compares both regular text-based PDF files and image-based PDF files that originate
from scanned documents, automatically applying OCR (Optical Character Recognition)
processing to translate the images of typewritten text into editable text. Compare
provides access to files and version information stored in a DMS/CRM or SharePoint
and users can browse for files to compare as well as save comparisons into the
DMS/CRM or SharePaint.

Users can launch Compare from the environment that suits them:

e Launch a comparison of an attachment (Word or PDF) directly from an email
message

e Launch a comparison from within Word or PowerPoint

e Launch a comparison from within a DMS/CRM or SharePoint

Understand the changes

Compare provides an intuitive interface that enables users to navigate easily between
changes. Category View divides changes according to type, for example, numbering
changes, punctuation changes or matching changes, enabling users to quickly focus on
the changes that are important to them.

10
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Implement the changes

Compare includes the ability to accept and reject changes placing it at the centre of the
review and comparison document lifecycle. Users can accept and reject changes
(individually or as a group) from within Compare and create a new Word document that
includes all their changes.

File share and sync

Workshare’s online services provide a secure file sharing and online collaboration tool
that enables users to store, share, and collaborate on content. There are several ways
of interacting with the online services offered by Workshare, either online through a web
browser or using special apps. The Workshare desktop app is the app for use on PCs
and it is installed as part of the Compare installation when you select the File Share &
Sync product.

Note: Workshare’s mobile apps are apps designed for use on smartphones and
tablets that provide access to documents in Workshare online while on the move.

Users can sync documents safely across all their devices automatically updating
content between Workshare online and their desktop and mobile devices.

With the Groups functionality, users can easily organize and manage files and projects,
ensuring the correct users and permissions are applied to a group. Tools for
commenting, annotating, and file comparison are available to support all stages of
document evolution. Users receive updates when files in particular groups are being
accessed, commented on, or modified by other reviewers, so ideas and conversations
are never missed. Once new file versions are uploaded, users can compare old and
new versions to see at a glance what has changed.

Users can access, review, and collaborate on files from any device, supporting
company-wide mobility initiatives. Users can also select files to save for offline access,
enabling users to work on files without Internet access. Once the device is connected
again, all updates are synced back as a new version.

IT security controls are available at an account level, allowing data governance
regulations to be met, and reduce the risk of accidental data loss. For added security,
organizations can choose where their corporate data is stored (public cloud, custom
public cloud, or hybrid). Finally, Workshare online can be integrated with existing DMS
to securely mobilize content, and get the most out of IT system investments.

With Compare, users can save and share Redlines or Office files (directly from
Compare or Office) to Workshare online so they can access them on their other devices
and on the move. Once shared, users can see their shared document, spreadsheet or
presentation come alive and understand who'’s reviewing it online - directly from Word,
Excel or PowerPoint.

11
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DMS/CRM integration

Workshare Compare can integrate with your DMS or CRM as well as SharePoint to
provide comparison and other functionality.

Note: To integrate with a DMS/CRM or SharePoint, Workshare Compare must be
installed with the relevant integration selected and additional details may need to be
configured in the Workshare Configuration Manager. Refer to your system
administrator for further information.

The specific functionality available with each DMS/CRM integration is detailed in the
table below:

Functionality Share NetDocu iManage OpenText Worldox

Point ments

When comparing,
browse to DMS
from select dialog

SN

When comparing,
save Redline to
DMS

Right-click:
Compare with
Workshare

'y

Right-click: Open
in Word with
Workshare

Browse from
desktop app to
add files to
Workshare

LX XA A

LX XA A

NIENIENIE R
£
TN

N X
N X

Accessing Workshare Compare

Workshare Compare can integrate with Microsoft Word, Excel, PowerPoint and Outlook
so that comparison is available from within these Office applications. Additionally,
Workshare Compare and Workshare Compare for PowerPoint are available as
standalone applications.

After you have installed Compare, the Workshare tab is added to the ribbon in your
Microsoft Office applications - Word, Excel and PowerPoint. The addition of Compare
does not affect the standard functionality of Word, Excel or PowerPoint. You can
operate these applications as usual and access the Compare functionality as required.

Workshare Compare functionality can also be accessed in the following ways:

12
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The Workshare Compare standalone application can also be accessed in the following
ways:

e Right-click closed Word or PowerPoint documents and select Compare with
Workshare.

¢ Right-click closed PDF documents and select Compare with Workshare or
Open in Word with Workshare.

e Click the Attachments dropdown in the Workshare tab in the email message
window when you receive an email that contains an attachment (Word and PDF)
to launch Workshare Compare.

o Right-click any file and select Workshare/Send to Group.

The Workshare Compare standalone application can also be accessed in the following
ways:

e Double-click the Workshare Compare icon on the desktop.

e From the Start menu, select Programs, Workshare, Workshare Compare.

The Workshare Compare for PowerPoint standalone application can also be accessed
in the following ways:

e Double-click the Workshare Compare for PowerPoint icon on the desktop.

e From the Start menu, select Programs, Workshare, Workshare Compare for
PowerPoint.

Note: Workshare Compare can be installed without Microsoft Office integration. In
this case, the Workshare tab is not available. The Workshare comparison
functionality is only available from the Workshare Compare applications.

Start menu

After you have installed Workshare Compare, the following elements are added to the
Start menu:

e Under Workshare:
= Workshare Compare
= Workshare Compare for PowerPoint
= Workshare Configuration (User Mode)
= Workshare Configuration Assistant
= Help

e Under Workshare Desktop
= Workshare

13
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Workshare tab

In Office applications, the Workshare tab is included as follows:

B B O = (2

_ompare | Toggle Saveto Share Cptions Help
Fanel My Files - -

_ompare Sharing Cptions Info

Whether these options are included in the tab is configurable from the General > User
Interface category in the Workshare Configuration Manager. Refer to Workshare
Configuration Options for further information.

The Workshare tab includes the following options:
Group Iltem Description

Compare Compare Microsoft Word and PowerPoint only.

Enables you to compare a Word or PowerPoint file with a
previous version of the same file or with another file. Refer to
Overview - Comparing Documents and Introducing Compare
for PowerPoint for further information.

Sharing  Toggle Displays/hides the Workshare Connect panel in your Office
Panel window where you can see what's happening with a
collaboration in real-time. Refer to Getting Content Online for
further information.

Save to Enables you to save documents to Workshare online so they
My Files | will be accessible to you online at all times. Refer to Saving to
My Files for further information.

Share Enables you to share documents to groups in Workshare
online so you can collaborate on them with others. Refer to
Sharing to a Workshare group for further information.

Options  Options | Enables you to configure system parameters in the Workshare
Configuration Manager. Refer to Introducing the Workshare
Configuration Manager for further information.

Info Help Provides access to version, copyright and license information
about Workshare Compare as well as online help.

14
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Enabling Workshare Compare functionality

To ensure Workshare Compare functionality is fully enabled, you should work with
saved documents. If you are working in Microsoft Office on an unsaved document and
you select Compare, the following message is displayed:

Workshare >
[ The document needs to be saved
i The Workshare functionality you have selected is not
currently enabled for an unsaved document.

ey

Licensing

After installation, you are prompted to log in to your Workshare account in order to
retrieve your license entitlements. This can be in either of the following ways:

e When File Share & Sync is included in the installation, the Workshare desktop
app is launched after install and you will see the following:

5} Workshare
Bile  Yew  Help

5 viorkshare

(=) Workshare

Welcome, let's get started

Entist your #nall 330ress 1 S50 in of tegisser

B Sign in with Microsalt wark account

Enter your Workshare credentials (email address and password) and click Sign
in. Your license entitlements are retrieved and you have access to all
Workshare functionality. Your license entitlements are shown in the My
Products tab of the Workshare Configuration Manager.

15
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If you do not log in at this point, then.....

e The first time you access Workshare functionality, for example, by clicking any
option in the Workshare tab, you will see the following:

@ Workshare 9 X

Sign in

to validate your Workshare subscription

Password

Forgotten password

Why do I have to sign in?

Create an account

Note: You can also open the Workshare Configuration Manager, select the My
Products tab and click Sign in.

Enter your Workshare credentials (email address and password) for Workshare and
click Sign in. Your license entitlements are retrieved and you have access to all
Workshare functionality. Your license entitlements are shown in the My Products tab of
the Workshare Configuration Manager.

Users who do not yet have a Workshare account can click Create an account in the
login dialog. Workshare checks their email address and will automatically register them
against your corporate Workshare account and update their license entitlement.

16
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Chapter 2. Comparing Documents

This chapter describes Workshare Compare, a standalone application that enables you
to compare two or more documents. It includes the following sections:

e QOverview — Comparing Documents, page 18, introduces the Workshare
Compare application.

e Performing Comparisons, page 19, describes how to compare a document
against an earlier version of the document or against a different document using
Workshare Compare.

e Ensuring Successful Comparisons, page 24, describes how Workshare
Compare performs comparisons using auto retry mode and failsafe mode.

o Workshare Compare Main Window, page 27, describes the Workshare
Compare environment and provides an overview of the functionality available.

e Working with Redlines, page 45, describes the tools available to you when
working with the compared (Redline) document after a comparison.

17
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Overview - Comparing Documents

Note: This chapter describes how to compare Word documents and PDF files. The
comparison of PowerPoint presentations is described in Chapter 3.

The Workshare Compare application compares documents — the original document and
the modified document — and produces a comparison (Redline document), enabling you
to instantly see any differences between them. In one view, you can see the source
documents and the resulting DeltaView Redline. You can compare an original
document against several different modified documents and see the Redline for each
comparison in a different tab. Documents can be stored in your DMS or CRM, locally or
on your network.

You can compare any of the following file formats:
DOC DOCX PDF RTF TXT

Workshare Compare’s powerful engine accurately and reliably displays document
changes in a Redline document with the differences clearly marked. For example,
deleted-textisred-and-struck-through and added text is blue and double underlined. All
content is compared including images, tables and embedded Microsoft Excel tables.
You can review the Redline, navigating between the changes and accepting or rejecting
the changes to create a new and revised document. To make the review easier, you
can customize how the changes are highlighted within the document.

RUN A COMPARISON

Launch Workshare Compare, select

the documents to compare and run

your comparison.

ACCEPT/REJECT CHANGES

In Compare, review and apply the

changes you want.

SAVE AND SHARE

Save your revised document locally or

in your DMS, or share it with others.

18
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PDF comparison

Workshare Compare can compare both regular text-based PDF files and image-based
PDF files that originate from scanned documents. Workshare Compare compares
regular PDFs by converting them to RTF before performing a comparison. With image-
based PDF files, Workshare Compare will first apply OCR (Optical Character
Recognition) processing to translate the images of typewritten text into editable text and
produce an RTF file.

PDF files that originate from scanned documents may include:

o PDF files generated from files that have been scanned: OCR (Optical Character
Recognition) has already been used to translate images of typewritten text into
editable text. Workshare Compare supports the comparison of such PDF files.

o PDF files that have been created directly from the scanning: Where OCR has
not been used and PDF files contain pure images of text. Workshare Compare
applies OCR to the PDF files before performing comparisons.

Notes:
If you compare scanned PDF files without applying OCR, it may result in a blank
Redline.

Workshare Compare can perform OCR on the following languages: English, Danish,
Dutch, Finnish, French, German, Italian, Norwegian, Polish, Portuguese, Spanish,
Swedish and Russian.

Performing Comparisons

You can compare your original document against any previous version of the document
or against another document entirely. For example, there may be ten versions of a
document in your DMS. You can open version 3 and compare it against version 5. You
can also compare a document against multiple versions. For example, you can open
version 3 and compare it against version 5, version 7 and version 10.

Note: You cannot compare secure PDFs, meaning PDF files with security settings
configured.

You can launch Workshare Compare and perform comparisons from within Microsoft
Word, from your desktop, from right-click options or from an email and each of these
scenarios is described in the following sections.

19
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Launching Workshare Compare from Microsoft Word

In this scenario, you first open your document in Microsoft Word.
To compare documents:

Click Compare in the Workshare tab. The Compare Documents dialog is displayed with
the open document in the Original Document field. Select the files to compare it with
as described in Launching Workshare Compare from your desktop.

Launching Workshare Compare using right-click options

You can launch Workshare Compare by right-clicking documents in Windows Explorer
or in your DMS (iManage/OpenText/Worldox).

¢ Right-click the original document and select Compare with Workshare. The
Compare Documents dialog is displayed with the selected document in the
Original Document field. Select the files to compare it against as described in
Launching Workshare Compare from your desktop.

e Select the original and modified documents, right-click and select Compare with
Workshare. The Compare Documents dialog is displayed with the selected
documents in the Original Document and Modified Document fields. Continue
as described in Launching Workshare Compare from your desktop.

You cannot launch Workshare Compare from SharePoint using right-click options.

Launching Workshare Compare from email

When you receive an email with a Microsoft Word or PDF attachment, you can compare
the attachment with any document on your local file system, SharePoint or DMS/CRM.
This feature can be used to compare the attached file with a previous version or
another document on your computer.

To compare an attachment from Microsoft Outlook:
1. Click the Attachments dropdown list that appears in the Workshare tab
D O N e —

Message Adobe PDF Waorkshare

Attachments =
@_] Sample Modified Document.docx
@_] Sample Criginal Document.doox

'@ combine,pdf

20
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2. Select the attachment you want to compare. The Compare Documents dialog is
displayed with the selected attachment in the Original Document field. Select
the files to compare it against as described in Launching Workshare Compare
from your desktop.

Launching Workshare Compare from your desktop

In this scenario, you launch Workshare Compare as a standalone application from your
desktop or the Start menu. You then select the documents you want to compare.
Launching Workshare Compare in this way enables you to perform one-to-many
comparisons - comparing a single original document against multiple modified

documents.
To compare documents:

1. Double-click the Workshare Compare shortcut on your desktop or from the Start
menu, select All Programs > Workshare > Workshare Compare. The
Compare Documents dialog is displayed:

Waorkshare Compare X

(=) Workshare

Please select the documents you want to compare:

Original Document:

|

| | Rl
Modified Document: Qﬁ
| ul=
| £
iy

Rendering Set:
Standard | | B

Comparison Mode:

Help K, Cancel
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. Select the original document you want to compare:

o Click to the right of the Original Document field.

o Navigate to the document location in your local file system, SharePoint or
DMS/CRM.

o Click Open.

The selected document is displayed in the Original Document field.

Tip: You can also enter text directly into the text box. Workshare Compare will
predict locations as you type. This is possible for locations accessible from the
local machine but not for locations in a DMS.

Select the document you want to compare with the original document:

= Click to the right of the Modified Document field.

o Navigate to the document location in your local file system, SharePoint or
DMS/CRM.

= Click Open.

The selected document is displayed in the Modified Document field.

Tip! If you want to compare a recently used file, click the dropdown * in the
Original Document and Modified Document fields and select the documents
you want to compare. These lists contain the last 10 documents you have used.

Tip! To swap the original and modified documents, click . This button is
only available if you are comparing two documents rather than comparing
multiple documents against an original document.

If you want to compare the original document against another document, click
. An additional Modified Document field is added.

Select the document you want to compare with the original document:

o Click to the right of the second Modified Document field.

= Navigate to the document location in your local file system, SharePoint or
DMS/CRM.

= Click Open.

Repeat step 5 to add further documents as required.
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7. From the Rendering Set dropdown list, select the rendering set you want to
use. Rendering sets contain a set of parameters that define how changes are
displayed in the Redline (compared) document. You can select from the
standard rendering sets provided with Workshare Compare or you can create
and customize your own rendering sets (described in Introducing Rendering
Sets).

Rendering Set:

Standard -

Standard

Standard no color

Standard no moves

Standard with caret for deletes
Standard with change numbers
- Standard with font changes
Standard with shading

Note: Clicking to the right of the Rendering Set field displays the
Rendering Sets Manager where you can create, modify and delete rendering
sets. For a full description refer to Introducing Rendering Sets.

8. From the Comparison Mode dropdown list, select the type of comparison you
want to perform from the following:
o Standard: Workshare Compare performs a regular comparison.

o Fast: When comparing a DOC or DOCX file against another DOC or DOCX
file, Workshare Compare performs a binary comparison which is faster than
a standard comparison.

Note: The Fast option is only available if the Enable fast comparison
parameter (Comparison > Administration category) in the Workshare
Configuration Manager is selected.

= Text Only: Workshare Compare performs a text-only comparison,
comparing only the text in a document and not the formatting or styles.

= Compare without OCR: Workshare Compare compares PDF files without
first performing OCR. With image-based PDF files, Workshare Compare will
first apply OCR (Optical Character Recognition) processing to translate the
images of typewritten text into editable text in order to compare. If you do
NOT want Workshare Compare to perform OCR, select this option.

9. Click OK. The comparison process is launched and an In Progress dialog is
displayed.

Tip: Progress is also indicated by the shading in the Task Bar icon for Workshare

Compare
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When the comparison is complete, the Redline is displayed in the Workshare Compare
window. If the original document has been compared against multiple documents, each
Redline is displayed in a different tab. For a full description of the Workshare Compare
interface, refer to Workshare Compare Main Window.

Note: When comparing a PDF file, the display may vary according to the type of PDF
- the software used to create the PDF file. For example, Adobe, Amyuni, CutePDF,
novaPDF, and so on.

Ensuring Successful Comparisons

If Workshare Compare cannot complete the comparison, it will do one of two things:
¢ Invoke auto retry mode, if it is enabled.

¢ Invoke failsafe mode, if auto retry mode is not enabled or if Workshare Compare
cannot complete the comparison in auto retry mode.

Auto retry mode

If Workshare Compare is unable to complete the comparison, and auto retry mode is
enabled, then Workshare Compare attempts to perform the comparison using reduced
settings. For example, Workshare Compare may attempt to compare the documents
without comparing field codes or without comparing footnotes. Workshare Compare
repeatedly attempts to perform the comparison disabling settings one at a time until the
comparison is successful.

Note: Auto retry mode is enabled in the rendering set — the Allow Auto Retry
parameter in the Comparison Options category of the Rendering Sets Manager.

Once the comparison is successful, a message is displayed informing you that the
comparison has been performed using reduced settings. Click OK and scroll to the
Redline Options Summary, which is displayed at the beginning or end of the Redline
according to the settings in the selected rendering set (in the Redline Options category
of the Rendering Sets Manager). Even if the rendering set does NOT have the Include
Redline Options Summary parameter selected, when Workshare Compare performs
an auto retry the Redline Options Summary is always displayed after the comparison.

The Redline Options Summary indicates which settings Workshare Compare disabled
in order to perform the comparison. For example:

Redline Options Summary
Option: Status:
Redline Statistics at End of Document ON

Include Redline Comparison Summary OFF
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Redline Options Summary
Show Line Numbering

Show Change Numbers

Show Change Bars on Left

Show Hidden Text

Detect List Numbering Changes
Compare Headers/Footers
Compare Footnotes

Display Compare Footers

Ignore Embedded Objects/Images
Compare at Character Level
Compare Numbers at Character Level
Show Moved Deletions

Show Changes to Spaces

Show Paragraph Changes

Ignore Case Changes

Ignore Textboxes

Ignore Field Codes

Ignore Tables

Comparing Documents

OFF
OFF

ON

OFF

ON

ON

SET OFF
OFF
OFF
OFF
OFF
OFF
OFF
OFF
OFF

SET ON
OFF
OFF

Note: The comparison may take longer than usual because Workshare Compare is
attempting to compare using different settings.

The status indications are as follows:

ON This setting is selected and was applied during the comparison.

OFF This setting is not selected and was not applied during the comparison.

SET ON  This setting was not selected but was enabled by Workshare Compare
and applied during the comparison.

SET OFF This setting was selected but was disabled by Workshare Compare and
not applied during the comparison.

If Workshare Compare cannot complete the comparison even using reduced settings,

failsafe mode is invoked.
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Failsafe mode

If Workshare Compare is unable to complete the comparison and auto retry mode is
disabled, or if Workshare Compare cannot complete even a reduced comparison in
auto retry mode, then failsafe mode is invoked. Failsafe mode means that Workshare
Compare performs a text-only comparison, comparing only the text in a document and
not the formatting or styles.

You can manually invoke failsafe mode so that a text-only comparison is performed.
You may want to do this if, after a full comparison, your Redline was not fully shown in
Workshare Compare for any reason. Additionally, you may want to do this if you are
more interested to see text changes rather than formatting and style changes.

To manually invoke failsafe mode:

Before running the comparison, select Text Only as the Comparison Mode in the
Compare Documents dialog.
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Workshare Compare Main Window

The Workshare Compare main window enables you to view Redlines - the results of a
comparison between an original document and a modified document. You can view (in
one work area) both source documents, the Redline and a summary of the changes
between the two source documents.

Quick Access Toolbar

Redline Tabs Ribbon
File Menu
Lo JnY il A Warkshare Compare - Sample Original Document-Sample M odified Document - 0O =
HOME MORE
Tomy T W | o g [ m‘ mk E ) Vit — Y il
@) ol <]le =p {%] |— O C-/ > 1last %
Mew Save Saveto Share Ema:l Brint Close PDF  Word Change Search Previous MNext Select  Edit Select
Comparison As= My Files = - - Al - Summary Specific - -
New Comparisor document Convert Change Navigation Comparison Themes  Layout
Samiple Original Document-Sample.. -
Change Summary ~ o x Source Documents v o ox
[ Changes | T Original: fila=//C:\. .. Modules \Sample Original Document.doc Madified: file://C:\. .. Modules\Sample Modified Document.doc
- 1 - -
® Category View (© List View © Status View || Degr Sirs, Dear SirMadam,
Accept Category
7 - PROPOSED QUALITY BONDS PLC ISSUE PROPOSED QUALITY BONDS PLC ISSUE
“ b Numbering Changes (3 unread] BY QUALITY BONDS PLC ISSUER PLC |BY QUALITY BONDS PLC ISSUER PLC
¥ 5 Br-Our comfort letter will || (“the Issuer”) (“the Issuer”)
| 8 7-For the avoidance of ¢
[ 28 27, Unless otherwise sp || Introduction Introduction
B 33, 32.The terms and cond)| - -
[ a_____bwthe [insert dates of m| || L 1 4
.| Punctuation Changes (2 unread) .
| Matching Changes (25 unread) [Date]

Footnote Changes (5 unread)
| Uncategorized Changes (28 unread

Dear Sis3iphladam,

PROPOSED QUALITY BONDS PLC ISSUE BY QUALITY BONDS PLC ISSL
(“the Issuer”)

Introduction

m )

Change Summary Window Redline Document Source Documents Window

When you select to run multiple comparisons, each resulting Redline is displayed in an
individual tab.
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Moving and placing windows

The Source Documents window and the Change Summary window can easily be
moved to different positions in the Workshare Compare main window according to
individual preference.

Left-click the title bar of the Source Documents window or Change Summary window
and the drag the window to your preferred position. The selected window will float over
the workspace.

To dock a window:

Left-click the title bar of a floating window and keep the mouse button pressed.
Positioning arrows appear at the top, bottom, left and right of the Workshare Compare
main window, as well as in the center.

Sample Original -
Change Summary  —
Changes | Search —

@ Category View O List View O Status View

Accept  Category

Numbering Changes (5 unread)
Punctuation Changes (2 unread)
Matching Changes (25 unread) -ALONE BONDS
Footnote Changes (6 unread)
Uncategorized Changes (28 unrsad)

oOoooO

— agraph 2 below)

( BONDS PLC ISSUER PLC

Introduction —

Move the mouse pointer over the required positioning arrow and release the mouse
button. The window is docked in the selected location. For example, dragging the
Change Summary window over the left positioning arrow will dock the Change
Summary window down the left side of the Workshare Compare main window.

To hide awindow:

Click * in the top right corner of the Source Documents window or the Change
Summary window or use the options in the Layout group on the Home tab.
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To auto-hide a window:

Click * in the top right corner of the Source Documents window or the Change
Summary window. The selected window is hidden with just a tab remaining.

For example, if the Change Summary window is displayed on the left side of the
Workshare Compare main window:

10.Click ql, the Change Summary window is hidden with just a tab displayed on the
left side.

11.Hover over this tab, the Change Summary window is displayed again and you
can work in it as required.

12. Click elsewhere, for example in the Redline, the Change Summary window is
automatically hidden again.

Sample Original Document-Sample... x

Change Summary

Changes | Search

@ Category View () List View () Status View

| Accept Category |

|| Numbering Changes (
Punctuation Changes

Sample Original Document-Sample... X

ource Documents

& (o
] Matching Changes (2| =
E] Footnote Changes (6 = iginal: file://C:\Program Files\Workshare \Module:
w
[l Uncategorized Chan 5 )
= ear Sirs,
‘UE SRS
Eﬁﬁfl?’\s'EBDOJ Sample Original Document-Sample... X
_ £ Change Summary v B X
Introduction E . ) -
‘® | Changes | Search Yigng
1. This ar|| £ '
%S @ Category View (O List View O Status View
3 Accept Category Iss
"] Mumbering Changes (5 unread) 2 |54
'] Punctuation Changes (2 unread)
[] Matching Changes (25 unread)
'] Footnote Changes (6 unread)
[} Uncategorized Changes (28 unread) 3 50

To turn off auto-hide, click .
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Quick access toolbar

N A E &

The quick access toolbar provides one-click access to popular functionality. By default,
the New Comparison, Open Comparison, Save and Save As buttons are included in
the quick access toolbar. By clicking the arrow to the right of the quick access toolbar,
you can customize it as follows:

Customize Quick Access Toolbar Select/deselect the New Comparison, Open
Comparison, Save or Save As options to display/hide

«  New Comparison . . .
these options in the quick access toolbar.

%

Open Comparison .
Save Select More Commands to add additional options to the
quick access toolbar.

%

%

Save As...

Select Show Below the Ribbon to display the quick
' access toolbar below the ribbon.

More Commands...

Show Below the Ribbon
. Select Minimize the Ribbon to hide the details of the

Minimize the Ribb | . : . :
nimize Fhe Rhen ' ribbon until you click the Home, Review or View tabs.

Note: To change the commands that appear in the quick access toolbar, right-click in
the ribbon and select Customize the Ribbon. Refer to Customize the Workshare

ribbon.
File menu
Clicking File displays a menu with the following options:
Option Description
New Comparison Opens the Compare Documents dialog enabling you to

perform a new comparison. Refer to Launching
Workshare Compare from your desktop.

Open Comparison Enables you to open a saved comparison. Comparisons
are saved as Workshare DeltaFiles (.WDF). Refer to
Opening saved Workshare DeltaFiles.

Save Enables you to save the current comparison. Refer to
Saving Redlines.
Save As Includes the following sub-options:
Comparison Enables you to save the Redline as a WDF, DOC,
document DOCX, TXT, RTF, HTM or PDF file. Refer to Saving

Redlines.
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Word document with
Track Changes

Save to My Files

As Comparison
document

As Word document
with Track Changes

Share

As Comparison
document

As Word document
with Track Changes

Email
Attach as PDF

Attach as PDF (only
pages with changes)

Attach as Word
document with Track
Changes

More email
options....

Print
Comparison only

Comparison +
Modified

Comparing Documents

Description

Enables you to save the Redline as a DOCX document
with the changes shown as track changes. Refer to
Saving Redline as track change document.

Includes the following sub-options:

Enables you to save the Redline to Workshare online as
a WDF, DOC, DOCX, TXT, RTF, HTM or PDF file.
Refer to Saving Redlines to Workshare online.

Enables you to save the Redline to Workshare online as
a DOCX document with the changes shown as track
changes. Refer to Saving to Workshare online as track
change document.

Includes the following sub-options:

Enables you to share the Redline to a group in
Workshare online as a WDF, DOC, DOCX, TXT, RTF,
HTM or PDF file. Refer to Sharing Redlines to
Workshare online.

Enables you to share the Redline to a group in
Workshare online as a DOCX document with the
changes shown as track changes. Refer to Sharing to
Workshare online as track change document.

Includes the following sub-options:

Converts the Redline to PDF and opens a hew email
window with the PDF attached. Refer to Sending by
email.

Converts the changed pages in the Redline to PDF and
opens a new email window with the PDF attached.
Refer to Sending by email.

Converts the Redline to a Word document with the

changes shown as track changes and opens a new
email window with the document attached. Refer to
Sending by email as track change document.

Enables you to select which documents from the
comparison to email and in what format. Refer to
Sending by email.

Enables you to print the Redline and includes the
following sub-options: Refer to Printing Redlines.

Enables you to print the Redline.

Enables you to print the Redline and the modified
source document.
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Option Description
Comparison + Enables you to print the Redline, the modified source
Modified + Original document and the original source document.
Print Preview Enables you to preview the print output and includes the
following sub-options:
Comparison only Enables you to preview the Redline.
Comparison + Enables you to preview the Redline and the modified
Modified source document.
Comparison + Enables you to preview the Redline, the modified
Modified + Original source document and the original source document.
Help Includes the following sub-options:
Help Provides access to online help.
About Displays version and copyright information about

Workshare Compare.

Keyboard shortcuts Displays a list of keyboard shortcuts available in
Workshare Compare.

License Displays information about your Workshare Compare
license in the My Products page of the Workshare
Configuration Manager.

Workshare Config Opens the Workshare Configuration Manager where, if

Manager you have permission, you can configure system
parameters. Refer to Introducing the Workshare
Configuration Manager for further information.

Exit Workshare Closes the Workshare Compare application. You are
Compare prompted to save any open Redlines.
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Home tab

The Home ribbon provides access to key functionality in Workshare Compare.

FILE HOME MORE

h SN DTel=a Fa el BE

Mew Save Saveto Share Email Print  Close PDF  Word Change Search Previous MNext . Select  Edit Select
Comparison As=  MyFiles» = - - All - Summary Specific - -

Mew Comparison document Convert Change Mavigation Comparison Themes  Layout

The options are described in the following table.

Group Option Description

New New
Comparison

Opens the Compare Documents dialog enabling
you to perform a new comparison. Refer to

Comparison Save As

Document

Comparison

Launching Workshare Compare from your
desktop.

Includes the following sub-options:

Enables you to save the Redline as a WDF, DOC,

document DOCX, TXT, RTF, HTM or PDF file. Refer to
Saving Redlines.

Word Enables you to save the Redline as a DOCX

document document with the changes shown as track

with Track changes. Refer to Saving Redline as track change

Changes document.

Save to My Files

Includes the following sub-options:

As Enables you to save the Redline to Workshare
Comparison online as a WDF, DOC, DOCX, TXT, RTF, HTM or
document PDF file. Refer to Saving Redlines to Workshare
online.
As Word Enables you to save the Redline to Workshare
document online as a DOCX document with the changes
with Track shown as track changes. Refer to Saving to
Changes Workshare online as track change document.
Share Includes the following sub-options:
As Enables you to share the Redline to a group on
Comparison Workshare online as a WDF, DOC, DOCX, TXT,
document RTF, HTM or PDF file. Refer to Sharing Redlines
to Workshare online.
As Word Enables you to share the Redline to a group on
document Workshare online as a DOCX document with the
with Track changes shown as track changes. Refer to
Changes Sharing to Workshare online as track change

document.
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Convert

Option
Email

Attach as
PDF

Attach as
PDF (only
pages with
changes)

Attach as
Word
document
with Track
Changes

More email
options...

Print

Comparison
only

Comparison +
Modified

Comparison +
Modified +
Original

Close All
PDF

Word
Open in Word

Comparing Documents

Description
Includes the following sub-options:

Converts the Redline to PDF and opens a new
email window with the PDF attached. Refer to
Sending by email.

Converts the changed pages in the Redline to
PDF and opens a new email window with the PDF
attached. Refer to Sending by email.

Converts the Redline to a Word document with the
changes shown as track changes and opens a
new email window with the document attached.
Refer to Sending by email as track change
document.

Enables you to select which documents from the
comparison to email and in what format. Refer to
Sending by email.

Enables you to print the Redline and includes the
following sub-options: Refer to Printing Redlines.

Enables you to print the Redline.

Enables you to print the Redline and the modified
source document.

Enables you to print the Redline, the modified
source document and the original source
document.

Closes all open comparisons.

Enables you to convert the Redline to PDF. Refer
to Converting Redline to PDF.

Includes the following sub-options:

Opens the Redline in Microsoft Word where you
can edit it. Refer to Editing Redlines.
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Group Option Description
Open in Word  Opens the Redline in Microsoft Word with the
with Track changes converted to track changes so you can
Changes implement changes using track changes
functionality. Refer to Showing changes as track
changes.

Note: The Convert to Track Changes option is
only available if the Enable ‘Convert to Track
Change document’ parameter is selected in
the Workshare Configuration Manager
(Comparison > User Interface category).

Change Change Displays/hides the Change Summary window.
Navigation  Summary

Search Displays the Search tab in the Change Summary
window enabling you to search for specified text or
keywords in the Redline and source documents.

Previous Navigates to the previous change and highlights
the entire change in the Redline. Refer to
Navigating between changes.

Next Navigates to the next change and highlights the
entire change in the Redline. Refer to Navigating
between changes.

First Navigates to the first change and highlights the
entire change in the Redline. Refer to Navigating
between changes.

Last Navigates to the last change and highlights the
entire change in the Redline. Refer to Navigating
between changes.

Specific Enables you to navigate to a specific change
number. The entire change is highlighted in the
Redline. Refer to Navigating to a specific change

number.
Comparison Select Enables you to select a different rendering set
Theme from the dropdown list and Workshare Compare

automatically re-runs the comparison applying the
selected rendering set. Refer to Introducing
Rendering Sets.
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Group Option Description

Edit Opens the Rendering Sets Manager where you
can apply different rendering sets to a comparison
and, if you have permission, you can add, edit and
delete rendering sets. Refer to Introducing
Rendering Sets.

Layout Select Enables you to select what is displayed in the
Workshare Compare window.

Comparison Hides the Source Documents window and displays

only the Redline only.

Comparison + Displays the Redline as well as the original
Original document in the Source Documents window.
Comparison + Displays the Redline as well as the modified
Modified document in the Source Documents window.
Comparison + Displays the Redline as well as both source
Original + documents.

Modified

More tab
The More ribbon provides access to other useful functionality.
| Home More
|

= | @ ®

Swap Comparison Help

Mode - -

| Criginal/Modified Mode Info

The options are described in the following table.

Group Option Description

Original/  Swap Swaps the original and modified documents. Refer

Modified to Swapping the source documents.

Mode Comparison Enables you to select a comparison mode from the
Mode dropdown list and Workshare Compare

automatically re-runs the comparison in the
selected mode — Fast, Standard, Text Only or
Image Based PDF.

Info Help Includes the following sub-options:

Help Provides access to online help.
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Group Option Description
About Displays version and copyright information about
Workshare Compare.
Keyboard Displays a list of keyboard shortcuts available in
shortcuts Workshare Compare.
License Displays information about your Workshare

Compare license in the My Products page of the
Workshare Configuration Manager.

Customize the Workshare ribbon

To change the commands that appear in the Workshare Compare ribbons and quick
access toolbar, right-click in the ribbon and select Customize the Ribbon.

Waorkshare 9 >
Quick Access Toolbar Choose commands from: Customize the Ribbon:
Customize Ribbon File ~ Main Tabs ~
About A Main Tabs
-Ea Az Comparizon document B ] Home
@ Az Comparizon document A
E;‘ Az Word document with Track Char > Original/Modified
[? As Word document with Track Char I Mode
&7 Attach as PDOF I Info
&7 Attach as POF (only pages with cha
&7 Attach as Word document with Trac “
&1 Email v
€ Bt
Help
(@) Help '
Keyboard Shortouts
License

[T New Comparison
F‘:‘ Open Comparisan
Print Comparison

@ Print Comparison *

@ Print Comparison + Modified

@ Print Comparison + Modified + Crigin- New Tab New Group | | Rename...
Keyboard shortcuts: | Customize. .. Customizations: Reset

Corcel | |t

To customize the Compare environment to suit your needs, you can select which
commands to include in the Home and More tabs or add new tabs.

37



Comparing Documents

The Redline

The DeltaView Redline shows the results of the comparison between the original
document and the modified document. Changes are marked according to the rendering
set applied to the comparison. For example, deleted text could be red-and-struck
through and added text could be blue and underlined.

You can navigate between the changes in the Redline and accept/reject the changes to
create a new and revised document. You can also save the Redline locally, or to your
DMS or to Workshare online. All of these options are described in Working with
Redlines.

Redline tabs

/ Sample Original Document-Sample... xr Sample Original Document-Draft R...

When the original document has been compared against multiple modified documents,
each resulting Redline is displayed in a different tab. Select the tab header to display
the comparison in the Workshare Compare window. You can also display the tabs
simultaneously side by side by clicking and dragging the tab header across the
Workshare Compare window.

Sample Original Document-Sample... = - Sample Criginal Document-Draft R.. -

-

|

DRAFT ARRANGEMENT LETTEF ‘ About This Guide

Redline right-click menu

Right-clicking text or changes in the Redline displays a popup menu, providing rapid
access to some of the more commonly used tools.

Option Description

Copy Copies selected text to the clipboard.

Select All Selects all the content of the Redline.

Find Displays the Search tab in the Change Summary window enabling

you to search for specified text or keywords in the Redline and
source documents.
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Option Description

Find Next When you have specified text or a keyword in the Search tab,
navigates to the next occurrence of the specified search text or
keyword.

Edit Redline Opens the Redline in Microsoft Word where you can edit it. Refer to
Editing Redlines.

Zoom Enables you to change the display of the Redline from 20% to
200% of its original size.

Link to When text has been moved to another position, navigates and

Move highlights the text in its new or previous position in the Redline.

e When right-clicking text in its new position, clicking Link to
Move highlights the text in its previous position.

o When right-clicking text in its original position, clicking Link to
Move highlights the text in its new position.

You must right-click a move-type change for this option to be

available.
Link to Jumps to the Redline Summary (at the end of the Redline)
Change highlighting the selected change. You must right-click a change for

this option to be available.

The Include Redline Comparison Summary parameter
(Redline Options category of the Rendering Sets Manager)
must be selected in the applied rendering set.
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Redline comparison summary

At the beginning or end of the Redline, you can see a summary of the comparison and
a list of the changes found.

Document comparnison by Workshare Compare on 17 June 2014 13:18:14
Input:

Document 11D file:/fC\Wsersihelens\Desktop\Onginal Document docx
Description (Original Document

Document 2 1D file: IC\Users\helens\Desktop\combine. pdf
Description combine

Rendering set IStandard

Legend:
[nsertion
Dreteiton
Moved to
Style change
Format change

Inserted cell
Deleted cel
Moved cell
SplitMerged cell
Padding cell

Statistics:

Count

Insertions 3
Deletions 178
Moved from 0
Moved to 0
Style change| 0
Format changed 0
Total changes 181

In order for the Redline to include this summary, the Include Redline Comparison
Summary parameter in the Redline Options category of the Rendering Sets Manager
must be selected in the applied rendering set.
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Change Summary window

The Change Summary window provides a list of changes found between the source
documents. Selecting a change highlights the change in the Redline and displays the
position of the change in both the source documents. From the Change Summary
window, you accept and reject changes. Refer to Reviewing changes.

You can hide/display the Change Summary window by clicking Change Summary in
the Home tab.

Tip! The Change Summary window is by default positioned down the left side of the
Workshare Compare environment. It can be moved as required. Refer to Moving and
placing windows.

The Change Summary window includes two tabs — Changes and Search — and the
Changes tab has three views. These are described in the following sections.

Changes tab Category View

Changes | Search

@ Category View 0 List View © Status View

Accept  Category

4 Numbering Changes (5 unread)

2, 8-Cur comfort letter will be |
b, L-For the avoidance of doub
26, 27-Unless otherwise specific
33, 22-The terms and conditions
f Bthe [insert dates of manag

OO0OOE

Punctuation Changes (2 unread)
Matching Changes (29 unread)
Footnote Changes (2 unread)
Endnote Changes (1 unread)
Header Changes (1 unread)

Footer Changes (2 unread)

15 T Y

Uncategorized Changes (31 unread)

4 m b

Apply Accepted Changes

The Changes tab, Category View displays all the changes between the original
document and the modified document according to the type of change. The changes
can be grouped into any of the following categories:

o Numbering Changes: Any changes to numbering lists identified in a document.
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Whitespace Changes: Changes that only involve whitespace — ie
deletion/insertion of spaces or tabs, or a space changing to a tab or 3 spaces
changing to tabs.

Capitalization Changes: Any changes to the capitalization of a word.
Punctuation Changes: Any changes to a punctuation mark.

Spelling Corrections: Changes where a single word replacement includes the
deletion of a word that is not a dictionary word and the insertion of a dictionary
word in its place. The replacement word must also be a spell check suggestion
for the replaced word — for instance replacing ‘recieve’ with ‘receive’.

Word Variations: Changes which involve changing the form a word ie replacing
‘confirms’ with ‘confirmed’ — the two words (original and replacement) must come
from the same stem word and just have different endings. This relies on a
dictionary as well — refer to document above on instructions on how this can be
customized.

Matching Changes: Changes that are repeated and identical.

Suggested Changes: Changes that a reviewer could have neglected to make.
For example, there are 400 instances of “ACME INC” in the original document
but the reviewer has only changed 399 of these to “Workshare Inc”. The
Suggested Changes category will indicate that there is 1 change that might
have been missed.

Style Changes: Style changes in a document.

Font Changes: Changes made to font type, font style, font colour, underline
style, underline color and font effects.

Footnote Changes: Any changes in the footnote of a document.
Endnote Changes: Any changes in the endnote of a document.
Header Changes: Any changes in the header of a document.
Footer Changes: Any changes in the footer of a document.

Placeholder Changes: The change summary shows items for blocks of
placeholder text that are found to be matching between the original and modified
documents. While these are not changes between the two documents as such,
they highlight areas where the editing of the document may be incomplete.
Typical blocks of placeholder text might be ‘[Client Name]', ‘{Company Address]’
etc.

Boilerplate Changes: Changes that occur inside blocks of boilerplate text in a
special ‘Boilerplate Changes’ section. These changes merit special attention as
in general boilerplate text should not be modified. Note that the change is only
marked as a boilerplate change if it is found inside an occurrence of one of the
boilerplate text items in the original document.

Comment Changes: Changes that have been made to comments.

Uncategorized Changes: Changes that do not fall into any of the above groups.
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Changes tab List View

Changes | Search

(D) Category View @ List View ©) Status View

# Page line Accept Change Text .
1 11 (] M@MH
2 1,54 [C] Add page numher
2 1,35 [C] Add reference numher
4-5 1,13 [l Dear SirsSicMadam
6 150 [ the Lead Manager confil
7 1,50 [[] 1Thiswill vary
] 2,8 [] 5 ThelsadMan
g 2,13 5 B&.-Cur comfort
10 2,21 ]| 6. Z-For the avoic
11 2,25 O 6. 7.
12-13 2,26 [l Z____Any such clail
: a - an [ ) B —~ - ’

Apply Accepted Changes

Changes tab Status View

Changes | Search

(D) Category View () List View @ Status View

4 Accepted

3. 6-Cur comfort letter will be provided {
I Mot Accepted
4 Flagged

- Addcompanganddate
[ 33. F2.-The terms and conditions,

] m | 3

Apply Accepted Changes
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The Changes tab, List View displays
all the changes between the original
document and the modified document
in the order that they occur. The
following information is shown for each
change:

#: The number of the change in the
document. A change may have two
numbers when it includes two actions.
For example, a deletion and an
addition.

Page, Line: The page number and the
line number in the original document
where the change occurs.

Accept: Whether you
change or not.

accept the

Change Text: Details of the change.

The Changes tab, Status View
displays all the changes between the
original document and the modified
document according to their review
status — Accepted, Not Accepted or
Flagged. When you have selected the
checkbox to the left of a change, it
appears under Accepted.
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The Search tab enables you to search

Search tab
date [[] Ignore Case
[Search changed text only "] | Search |
# Pageline Accept Change Text

1 11 Add company and date
a0-41 5,2 [C] .._The audit opinion is valid
55-56 6,7 ] Weintend to provide you w
131 14,27 ([ Qur work did not extend to t
am ] v

for changes in the Redline that include
a specific keyword or text. Refer to
Searching for changes.

Source Documents window

The Source Documents window is where you can view the original document and the
modified document that have been compared. You can select (from the Layout group
in the Home tab) to display the original document, the modified document or both
documents in the Source Documents window.

Source Documents

Original: file:ffC:\Program Files\Workshare Modules'Sample Original Document.doc Modified: file: ffC:\. .. \Warkshare\Modules\Sample Modified Document.doc

-~

Comfort Letter

i The Lead Manager confirms that, in connection [ |
with the proposed issue of the Securities, it is
aware of guidance relating to due diligence issued
by the International Primary Market Association
from time to time, which will be followed by it in
connection with the proposed issue.

Our comfort letter will be provided to the

addressees of this letter solely in the context of
the due diligence procedures that you undertake,
or procure to be undertaken, pursuant to the
guidance referred to in paragraph 5 above in
connection with the contents of the offering
circular for the purpose of any due diligence
defence that you may wish to advance in

4 L3

Comfort Letter

. Qur comfort letter will be provided to the
addressees of this letter solely in the context of
the due diligence procedures that you undertake,
or procure to be undertaken, pursuant to the
guidance referred to in paragraph 5 above in
connection with the contents of the offering
circular for the purpose of any due diligence
defence that you may wish to advance in
connection with the contents of the offering
circular.  Accordingly our comfort letter will be
addressed to you for that purpose and may not be
relied on by you for any other purpose.

For the avoidance of doubt, nothing in paragraph
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You can scroll through both documents and selecting a point in one source document
automatically scrolls the other source document as well as the Redline to the same
point. The source documents are read-only and cannot be modified in any way. The
name of the source document is shown above the document.

Tip! The Source Documents window is by default positioned across the top of the
Workshare Compare environment. It can be moved as required. Refer to Moving and
placing windows.

Right-clicking text in the original document or the modified document displays a popup
menu, providing rapid access to some of the more commonly used tools.

Option Description

Copy Copies selected text to the clipboard.

Select All Selects all the content of the original or modified document.

Find Displays the Search tab in the Change Summary window enabling

you to search for specified text or keywords in the Redline and
source documents.

Find Next When you have specified text or a keyword in the Search tab,
navigates to the next occurrence of the specified search text or
keyword.

Zoom Enables you to change the display of the original or modified
document from 20% to 200% of its original size.

Working with Redlines

This section describes the tools available to you when working with the Redline
DeltaView after a comparison.

Navigating changes

After performing a comparison, you can review the Redline (the result of the
comparison) and look through the changes between the original and modified
documents. You can move between changes in the Redline by jumping from change to
change or searching for a specific change using change numbers or keywords. You can
also accept or reject the changes and create a new document based on your decisions
— refer to Reviewing changes.
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Navigating between changes

Selecting a change in the Change Summary window highlights the change in the
Redline and displays the position of the change in both of the source documents.

e Click Previous in the Home tab to move to the previous change and highlight
the entire change in the Redline. Click First to move to the first change in the
Redline.

e Click Next in the Home tab to move to the next change and highlight the entire
change in the Redline. Click Last to move to the last change in the Redline.

Navigating to a specific change number

Changes are allocated numbers, which are displayed next to the change in the Change
Summary window. A change may have two numbers when it includes two actions, for
example, a deletion and an addition. You can move to a specific change number in the
Redline.

To navigate to a specific change number:

1. Click Specific in the Home tab. The following dialog is displayed:

Workshare Compare >

Enter the change number to go to within the current document.

Change Mumber: | |

2. Inthe Change Number field, enter the number of the change you want to
display in the Redline.

3. Click Go To. The entire change is highlighted in the Redline.
4. Repeat steps 2 and 3 to navigate to further changes as required.

5. Click Close to close the dialog.

Tip! To maximize this feature, apply a rendering set with the Show Change
Numbering parameter selected in the Redline Rendering category, Change
Numbering section. Refer to Change Numbering. This shows all the change numbers

i 1 2
against each change in the Redline, for example, D22 S#&aidadam*
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Searching for changes

You can search for changes in the Redline that include a specified keyword or text.
Workshare Compare can search only the changes for the specified text or it can search
the text of the original or modified documents.

To search for a change:

1. In the Change Summary window, select the Search tab or click Search in the
Home tab.

2. Inthe text box at the top of the Search tab, enter the search criteria — the word
or words for which you want to search.

3. If the case is not important, select the Ignore Case checkbox.

4. Select where you want to search from the dropdown list. The options are as
follows:

o Search changed text only: Searches through all text in the Redline that has
been changed.

o Search text near a change: Searches through all text in the Redline that
has been changed and also text that is within 100 characters of a change.

= Search Original Document text: Searches through all text in the original
document.

= Search Modified Document text: Searches through all text in the modified
document.

o Search all Redline text: Searches through all text in the Redline.

5. Click Search. A list of changes that include the specified word or words is
displayed in the lower text area.

Change Summary v X
Changes | Search

comfort letter Ignore Case
[Search changed text only V] I Search

# Page,line  Accept Change Text

42 - 45 5,9 g Itswill be nacassany
48 -51 5,27 0 zz We shall answer au
58-89 53 O s The geidwhichis-at
:1) 83  Deatiloamiieener

a5 9.4 [[] DRAFT COMFORT LETTER
131 14,27 O Qurwork did not extend o't
pl) S TR '

Apply Accepted Changes

Selecting a change in the search results highlights the change in the Redline and
displays the position of the change in both the source documents.
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Reviewing changes

You can accept and reject changes from within Workshare Compare and create a new
Word document that includes all your changes. Changes can be accepted/rejected
individually or as a group. Using the Category View of the Changes tab, you can
choose to accept or reject an entire category. For example, the Matching Changes
category includes changes that are repeated and identical and you can accept or reject
them all at one time. Switching to Status View provides an easy way to quickly see
what changes haven't yet been reviewed.

To accept/reject changes:

1. Review the changes that you care about and mark them in any of the following
ways:
= Inthe Change Summary window, select the checkbox to the left of an
individual change to accept it.
o In Category View, select the checkbox to the left of a category to accept all
changes in that category.

Tip! You can select all changes in a category by selecting the category
checkbox and then deselect one or two changes within that category as
required.

= Right-click an individual change or a category and select Flag. This is a way
to highlight the change — perhaps for future consideration or to check
sources.

= Right-click an individual change or a category and select Mark as Read.
This is a way to indicate that you have reviewed the change but do not want
to give it a status.

Note: To reset a change marked as read, select Mark as Unread from the
right-click menu.

2. When you have completed your review, click Apply Accepted Changes at the
bottom of the Change Summary window. A new Word document is opened with
the changes accepted or rejected according to your selection. You can save this
document as your new master document.

Note: Changes to comments (grouped in the Comments category) will not be
accepted.

The comparison is not altered in any way so you can return to the comparison in
Workshare Compare and change your mind about whether to accept changes or
not. Every time you click Apply Accepted Changes, a new Word document is
opened with the current accept/reject statuses applied.
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You can also save the comparison as WDF file and this will save all your selections
along with the source documents and Redline document. You can open this WDF at a
later time and continue working or send it a colleague for further review.

Editing Redlines

A Redline remains an accurate comparison of two documents and cannot be directly
edited in Workshare Compare. However, you can open the Redline in Microsoft Word
and edit the document as required. There are two ways of opening the Redline in Word
— one where the changes appear as text and another where the changes appear as
track changes.

Showing changes as text

Using this method, changes appear as normal text with just the formatting to identify
them. For example, if the rendering set used in the comparison showed inserted text as
red with a double underline, then the text will appear as red with a double underline in
Word.

To open the Redline in Word:

1. Inthe Home tab, click Word and then Open in Word or right-click in the Redline
and select Edit Redline. The Redline is opened in Microsoft Word with the
default name Redline.docx. All the changes are displayed as ordinary text but
with formatting marks indicating whether they are additions, deletions and so on.

2. Edit the document as required.

3. Save the document. By default, the document is saved in a temporary folder.

Showing changes as track changes

Using this method, the changes are converted to track changes and you can implement
the changes using Microsoft Word’s track changes functionality.

Note: The converting to track changes functionality is only enabled, if the Enable
‘Convert to Track Change document’ parameter (Comparison > User Interface
category) in the Workshare Configuration Manager is selected.

To convert to track changes:

1. Inthe Home tab, click Word and then Open in Word with Track Changes. The
Redline is opened in Microsoft Word with all the changes displayed as track
changes.

2. Review the track changes and implement them as required.

3. Save the document. By default, the document is saved in a temporary folder.
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Changing the comparison

You can re-run a comparison swapping the source documents, changing the
comparison mode, applying a different rendering set or changing specific comparison
options.

Swapping the source documents

You can re-run a comparison exchanging the original document for the modified
document and the modified document for the original document. For example, if you
selected Document A as the original document and Document B as the modified
document, Workshare Compare compares Document A to Document B and presents
the changes made to Document A. You can then swap the original and modified
documents so that Document B is now the original document and Document A is the
modified document. Workshare Compare automatically re-runs the comparison,
comparing Document B to Document A, and presents the changes made to
Document B.

To swap the source documents:

Click Swap in the More tab to swap the source documents. Workshare Compare
automatically runs a new comparison, using the modified document as the original
document and the original document as the modified document. The new Redline is
displayed in the same tab replacing the first comparison.

Changing the comparison mode
You can re-run a comparison using a different comparison mode (or type) if required.
To re-run a comparison using a different mode:

In the More tab, click Comparison Mode and then select the required mode from the
following:

e Fast: Workshare Compare performs a fast comparison. When comparing a
.DOC file against another .DOC file, Workshare Compare performs a binary
comparison which is faster than a standard comparison because it is comparison
at the binary level. When comparing a .DOCX file against another .DOCX file,
Workshare Compare performs a faster comparison by converting the documents
to DOC followed by comparison at the binary level.

Note: The Fast option is only available if the Enable fast comparison
parameter (Comparison > Administration category) in the Workshare
Configuration Manager is selected.

e Standard: Workshare Compare performs a regular comparison.

e Text Only: Workshare Compare performs a text-only comparison, comparing
only the text in a document and not the formatting or styles.
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¢ Image Based PDF: Means that Workshare Compare will re-run the comparison
and force OCR processing on scanned/image content. You may want to try this
if Workshare Compare has performed a Standard or Fast comparison and
some scanned/image content has not been converted to text.

Note: This type of ‘forced’ OCR may be useful when scanned pages are
difficult to detect, for example, when they have lots of annotations on top of the
scans like Bates numbering, etc. or when the text is actually vector output (from
a CAD product for example) and there are no actual characters with fonts in the
PDF.

Workshare Compare re-runs the comparison using the selected mode and displays the
resulting Redline in the Workshare Compare main window.

Applying a different rendering set
You can re-run a comparison using a different rendering set.

To re-run a comparison with a different rendering set:

1. In the Home tab, click Select in the Comparison Themes group. A list of the
currently defined rendering sets is displayed.

Select  Edit Select

- -

Yo Standard

Standard no color

Standard no moves

Standard with caret for deletes
Standard with change numbers
Standard with font changes

I Standard with shading
2. Select the rendering set to apply.

Workshare Compare re-runs the comparison using the selected rendering set and
displays the resulting Redline in the Workshare Compare main window.
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Changing the comparison options
You can re-run a comparison changing specific options within the rendering set.
To re-run a comparison with different options:

1. In the Home tab, click Edit in the Comparison Themes group. The Rendering
Sets Manager is displayed.

) Rendering Sets - [m| *

Rendering Set:  Standard " Save Save As.. H Delete

Comparison Options Comparison Options
Select the document features o be compared.
Redline Options

Redline Rendering A Comparison Options
Allow Auto Retry
Detect List Numbenng Changes
Detect Footnote/Endnote Numbering Changes

Compare Headers/Footers

Compare Footnotes

O Compare at Character Level

O Compare Numbers at Character Level

O Ignore Embedded Objects/Images

[ Ignore Case Changes

[ Ignore Text Boxes

O Ignore Field Codes

Compare field contents as text
O Ignore Tables

O Display comments in redline
[ Detect Changes to Images

[ Ignore auto list against manual number list changes

Apply | Cancel || Help |

2. Edit the rendering set parameters as required. For example, select the Ignore
Tables checkbox. Rendering set parameters are described in Rendering Set
Parameters.

3. Do one of the following:

o Click Apply. Workshare Compare re-runs the comparison using the selected
parameters and displays the resulting Redline in the Workshare Compare
main window. Click OK to close the Rendering Sets Manager. Any changes
you made to the rendering set parameters are lost.
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o Click OK. The save dialog is displayed. Enter the name of an existing
rendering set to overwrite a rendering set or enter a new name to create a
new rendering set. Do not use the following characters when naming
rendering sets: <, >, :, \, “, /, \ or |. Click Yes. Workshare Compare re-runs the
comparison using the revised options and saves the revised options as the
specified rendering set. Click No. Workshare Compare re-runs the
comparison using the revised options and saves the revised options as a
temporary rendering set called “Custom rendering set”.

Note: The “Custom rendering set” will be selected in the Rendering Set dropdown list
the next time the Rendering Sets Manager is opened. However, once you navigate
away from the “Custom rendering set” and a different rendering set is selected and
the Rendering Sets Manager is closed, the “Custom rendering set” is lost.

Distributing Redlines

After you have compared your documents, Workshare Compare provides many options
for saving or circulating the Redline. Workshare’s DeltaView Redline can be distributed
in many formats, such as PDF or TXT or DOCX. Only if it is distributed as a WDF will
your ‘Accept’ and ‘Flag’ selections, as well as the source documents, be included. WDF
files can only be opened in Workshare Compare. The Redline can also be distributed
as a Word document with the changes shown as track changes. The following sections
describe how you can distribute your Redlines:

e Save locally or to your DMS, refer to Saving Redlines

e Save to Workshare online, refer to Saving Redlines to Workshare online
e Share to Workshare online, refer to Sharing Redlines to Workshare online
o Email, refer to Sending by email

e Print, refer to Printing Redlines

o Convert to PDF, refer to Converting Redline to PDF
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Saving Redlines

You can save the Redline as a Workshare Compare DeltaFile (WDF), which contains
all three documents (original, modified and Redline) as well as your ‘Accept’ and ‘Flag’
selections. You can also save just the Redline as a DOC/DOCX, RTF, HTM, TXT or
PDF file or you can save the Redline as a track change document.

You can save the Redline to your DMS/CRM, SharePoint or locally. The following
procedure describes how to save to NetDocuments as an example.

To save the Redline:

1. Click Save As and then Comparison document in the Home tab (or quick
access toolbar or File menu). The following dialog is displayed.

Workshare Compare >

Save

Select the option for saving the selected document

@ What do you want to do with the document?

Save a Mew Document w

Saves the comparison as a new document or version in
the current document system...

Help Cancel

2. Select whether you want to save the comparison as a new document or attach it
to the original or modified documents.
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3. Click OK. The NetDocuments Save As dialog is displayed.

m Save As x
Acme Ltd » Documents Search by "Document Na... 2@ = E
‘ Add Folder | | Go to Workspace Bz ~
Home Name Ver Date Modified Document D Type
Recent Documents "L Redmond MCP WP_Why Customers Use Box with... 1 07/07/201511:02  4823-8387-3829  Adobe Acroba...
4 Recent Locations = ND Original 1 27/04/201513:51  4850-0968-9635  Microsoft Wor...
T — @5 ND Modified 2 1 27/04/201513:51  4848-3869-4681  Microsoft Wor...
1= ND Modified 1 1 27/04/201513:50  4846-7414-3315  Microseft Wor...
4 W Acme Ltd = Modified DOC - Original DOCX 1 23/04/2015 21:44  4810-8126-1839  Microsoft Wor...
|5 Recent Workspaces
|5 Favorite Workspaces
7 Folders
- Demo Dave
4 [ Documents
|5} Recent Workspaces
|5} Favorite Workspaces

File name: |ND Qriginal - ND Modified 1
Save as type: | Adobe Acrobat File ( *.pdf) -

Save as new version | Description | Official version
Profile Templates

Client: Click to edit Matter: Click to edit DocType: Click to edit

Save Cancel

Note: If you are not working with a DMS or SharePoint, the LocalStore Save As
dialog is displayed or if you click Cancel in this dialog, a message is displayed
asking if you would like to save the Redline locally.

Tip! If you are working with a DMS or SharePoint but both documents
compared are local documents, then you can press the Shift key while clicking
Save and the LocalStore Save As dialog is displayed.

4. Browse to the location where you want to save the comparison and modify the
name of the comparison as required.
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5. From the Save as type dropdown list, select the format for the saved file from

the following:

Workshare DeltaFile Saves both the Redline and the source documents, as

(*.wdf) well as your ‘Accept’ and ‘Flag’ selections, as a
Workshare DeltaFile. This file can only be opened in
Workshare Compare.

Word Document Saves the Redline as a Microsoft Word file. The

(*.doc/*.docx) source documents and your ‘Accept’ and ‘Flag’
selections are not saved.

Text Only (*.txt) Saves the Redline as a text file. The source
documents and your ‘Accept’ and ‘Flag’ selections are
not saved.

Rich Text Format Saves the Redline as an RTF file. The source

(*.rtf) documents and your ‘Accept’ and ‘Flag’ selections are
not saved.

HTML Document Saves the Redline as a HTML document. The source

(*.htm) documents and your ‘Accept’ and ‘Flag’ selections are
not saved.

Adobe Acrobat File  Saves the Redline as a PDF file. The source

(*.pdf) documents and your ‘Accept’ and ‘Flag’ selections are
not saved.

Adobe Acrobat Saves the Redline as a PDF/A file. The source

PDF/A File (*.pdf) documents and your ‘Accept’ and ‘Flag’ selections are
not saved.

6. Click Save.

Saving Redline as track change document

You can also save the Redline as a Microsoft Word file that shows the changes as track
changes.

Note: The converting to track changes functionality is only enabled, if the Enable
‘Convert to Track Change document’ parameter (Comparison > User Interface
category) in the Workshare Configuration Manager is selected.

To save Redlines with changes as track changes:

1. Click Save As and then Word document with Track Changes in the Home tab
(or quick access toolbar or File menu).

2. Select whether you want to save the comparison as a hew document or attach it
to the original or modified documents.

3. Click OK. The NetDocuments Save As dialog is displayed.

4. Browse to the location where you want to save the track change document and
modify the name of the document as required.
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5. Click Save. The Redline is saved as a Microsoft Word document with the
changes indicated by track changes.

When you open the saved file in Microsoft Word, the changes are displayed as track
changes.

Opening saved Workshare DeltaFiles

When a comparison has been saved as a Workshare DeltaFile, you can open it from
Workshare Compare.

To open a saved comparison:

4. Click Open Comparison from the File menu. An Open dialog is displayed.

Note: Clicking Open when you work with a DMS/CRM or SharePoint accesses
the DMS/CRM or SharePoint. To open from a local or network drive, hold the
Shift key down when clicking Open or click Cancel in the DMS/CRM or
SharePoint open dialog.

5. Navigate to the location where the comparison is saved and select the WDF file
you want to open.

6. Click Open. The selected comparison is opened in Workshare Compare. The
source documents and the Redline are displayed as well as any ‘Accepted’ and
‘Flagged’ selections you made in the Change Summary window.

Saving Redlines to Workshare online

If you work with Workshare online, you can save Redlines there so they will be
accessible to you online at all times.

You can save the Redline as a Workshare Compare DeltaFile (WDF), which contains
all three documents (original, modified and Redline) as well as your ‘Accept’ and ‘Flag’
selections. You can also save just the Redline as a DOC/DOCX, RTF, HTM, TXT or
PDF file or you can save the Redline as a track change document.

Note: You can also use Save As and save the Redline to your Workshare sync folder
and it will be synchronized to Workshare online. Refer to Adding files to Workshare.
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To save the Redline to Workshare online:

1. Click Save to My Files and then As Comparison document in the Home tab
(or File menu). The Save to My Files dialog is displayed.

Note: If you are not logged in to Workshare online, you will be asked to log in
before the Save to My Files dialog is displayed.

& save to My Files - O X

o1 Create new folder

4 @ @ My Fies

] Waork in Progress
] S50

o Private

] Draft Contracts

File name: |Sample Original Document - Sample Modified

Save as type: | Adobe Acrobat File ( *.pdf) -

Save Cancel

2. Browse through My Files and select the folder where you want to save the
comparison.

Note: To create a new folder, click Create new folder, enter a name for the
folder and click Create.

3. In the File name field, modify the name of the comparison as required.
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4. From the Save as type dropdown list, select the format for the saved file from

the following:

Workshare DeltaFile Saves both the Redline and the source documents, as

(*.wdf) well as your ‘Accept’ and ‘Flag’ selections, as a
Workshare DeltaFile. This file can only be opened in
Workshare Compare.

Word Document Saves the Redline as a Microsoft Word file. The

(*.doc/*.docx) source documents and your ‘Accept’ and ‘Flag’
selections are not saved.

Text Only (*.txt) Saves the Redline as a text file. The source
documents and your ‘Accept’ and ‘Flag’ selections are
not saved.

Rich Text Format Saves the Redline as an RTF file. The source

(*.rtf) documents and your ‘Accept’ and ‘Flag’ selections are
not saved.

HTML Document Saves the Redline as a HTML document. The source

(*.htm) documents and your ‘Accept’ and ‘Flag’ selections are
not saved.

Adobe Acrobat File  Saves the Redline as a PDF file. The source

(*.pdf) documents and your ‘Accept’ and ‘Flag’ selections are
not saved.

Adobe Acrobat Saves the Redline as a PDF/A file. The source

PDF/A File (*.pdf) documents and your ‘Accept’ and ‘Flag’ selections are
not saved.

5. Click Save.

Saving to Workshare online as track change document

You can also save the Redline to Workshare online as a Microsoft Word file that shows
the changes as track changes.

Note: The converting to track changes functionality is only enabled, if the Enable
‘Convert to Track Change document’ parameter (Comparison > User Interface
category) in the Workshare Configuration Manager is selected.

To save Redlines to Workshare online with changes as track changes:

1. Click Save to My Files and then As Word document with Track Changes in
the Home tab (or File menu).

2. In the Save to My Files dialog displayed, select a folder in My Files (or create a
new one), specify a name for the track change document and click Save. The
Redline is saved as a Microsoft Word document with the changes indicated by
track changes.
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Sharing Redlines to Workshare online

When you work with Workshare online, you can share Redlines to groups there so you
can collaborate on them with others.

You can share the Redline as a PDF file or you can share the Redline as a track
change document.

Note: You can also use Save As and save the Redline to a group folder in your
Workshare sync folder and it will be synchronized to Workshare online. Using this
method, you could share the entire comparison, including the source files and your
‘Accept’ and ‘Flag’ selections as a WDF file. Refer to Adding files to Workshare.

To share the Redline to Workshare online:

1. Click Share and then As Comparison document in the Home tab (or File
menu). The Share dialog is displayed.

Note: If you are not logged in to Workshare online, you will be asked to log in
before the Share dialog is displayed.

Share *
@

A copy of your file will be shared to:

Enter group name

ﬂ} sample Original Document - Sample Modified Document & Version 1

Lde.2 RD

Cancel
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2. Enter the name of the group you want to share the Redline with. As you start to
enter the name, groups are suggested to you.

A copy of your file will be shared to:

Kn 0

Knowledge Group

Waorkshare, 1 members

Create a new group: Kn

3. Select a group or enter a new group name and click Create a new group.
4. Edit the name of the Redline by clicking 4 , modifying the name and then
clicking o

5. Click Share. The Redline is saved to the group in Workshare online and a
confirmation dialog is displayed.

Share *
@

©

File shared

A copy of Sample Original Document - Sample Modified Document
has been shared in the following group:

Sunset Project Group l 3

Link to file: &
https://my.waorkshare.com/#aroups/share/5c4afcce-588d-11e6-2415-000d3ab2f07h
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6. Continue in one of the following ways:

o Click Send email to open a new email in Outlook that includes a link to the
Redline in Workshare online. You can invite people to the group by sending
the email to them.

= Click Go to group to open the group in Workshare online where you can
see the Redline and set group permissions and members.

Note: Click to copy the link to the Redline to your clipboard. You can then
paste this link to another location, for example, an email or an instant message.

Sharing to Workshare online as track change document

You can also share the Redline to Workshare online as a Microsoft Word file that shows
the changes as track changes.

Note: The converting to track changes functionality is only enabled, if the Enable
‘Convert to Track Change document’ parameter (Comparison > User Interface
category) in the Workshare Configuration Manager is selected.

To share Redlines to Workshare online with changes as track changes:

Click Share and then as Word document with Track Changes in the Home tab (or
File menu). The Redline is saved as a Microsoft Word document with the changes
indicated by track changes and shown in the Share dialog as a DOCX file. Complete
the share process as described in the procedure above.

Sending by email

Workshare Compare integrates with your email system so you can send the Redline as
well as the original and modified documents as email attachments. You can send the
entire Redline or just the pages that include changes. You can also send the Redline as
a Microsoft Word file that shows the changes as track changes. This is useful if the
recipient does not have Workshare Compare.

To send a Redline as a PDF:

Click Email and then Attach as PDF in the Home tab (or File menu). The Redline is
converted to PDF and a new email window is opened with the PDF attached.

To send changed pages as a PDF:

Click Email and then Attach as PDF (only pages with changes) in the Home tab (or
File menu). The changed pages in the Redline are converted to PDF and a new email
window is opened with the PDF attached.
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To send source documents with the Redline:

1. Click Email and then More email options in the Home tab (or File menu). The
Email Comparison Documents dialog is displayed.

Warkshare Compare - Email Comparison Documents x

Select the documents to attach to a new emai message

Create a new message attaching

() Workshare 9's internal file format (DeltaFile)

Document Type Document Mame Document Format
[ m= original Document ‘ Sample Original Documen| | Word 97-2003 Document {*.doc) ‘
] mf: Modified Document ‘ Sample Modified Dnv:umE|| | Ward 97-2003 Document (*.doc) ‘
=" Redline Document ‘ Sample Original DUEU"“E”| Adobe Acrobat File (*.pdf) w

[ only indude pages with changes in Redline {PDF only)

2. Select the files to send by selecting one of the following options:
o Individual documents included in this comparison

Selecting this option displays a list of the documents included in the
comparison in the lower pane. Select the checkboxes to the left of the
documents you want to send. You can click in the Document Name fields
and modify the names of the documents.

Note: The original and modified documents are sent in Microsoft Word format
and the Redline is sent by default as a PDF. Click in the Document Format
field of the Redline to change the default format, for example, to RTF.
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o Workshare Compare’s internal file format (DeltaFile)

Selecting this option sends the compared documents as a DeltaFile which
contains all three documents (original, modified and Redline) as well as your
‘Accept’ and ‘Flag’ selections. A DeltaFile can only be opened in Workshare
Compare. The file extension for a DeltaFile is WDF.

Document Type Document Mame

£E] Workshare DeltaFile Sample Criginal Documen

Tip! Click in the Document Name field to change the name of the Redline.

3. If you only want to include the pages with changes in the Redline, select the
Only include pages... checkbox. This is only available when you are sending
the Redline as a PDF.

4. Click OK. An email message window is displayed with the selected files as
attachments.

5. Enter the recipient(s) name and any other text you want to include and click
Send.

Sending by email as track change document

You can also send the Redline as a Microsoft Word file that shows the changes as track
changes.

Note: The converting to track changes functionality is only enabled, if the Enable
‘Convert to Track Change document’ parameter (Comparison > User Interface
category) in the Workshare Configuration Manager is selected.

To send Redlines with changes as track changes:

Click Email and then Attach as Word document with Track Changes in the Home
tab (or File menu). The Redline is saved as a Microsoft Word document with the
changes indicated by track changes and a new email window is opened with the Word
document attached.
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Printing Redlines

You can print the entire Redline or just the pages that have changes, as well as either
of the source documents.

To print the comparison documents:

1. Click Print in the Home tab (or File menu) and then one of the following options:
= Comparison only
= Comparison + Modified
= Comparison + Modified + Original

The Print dialog is displayed.

Print ? >
Frinter
M arme: Microzoft #PS Docurment YWriter e Froperties

Status: Ready
Type: Mizrozoft %P5 Docurment witer w4
YWhere:  PORTPROMPT:

Comment [ Print o fle
Print range Copies

® &l Mumnber of copies: E =
(O Pages  from: |1 | b |1? |

2 3.! o 3| Collate
() Selection _1.|J_ _IJ'J_’

[ ] Print Fedline in black and white
] Orly print pages with changes

Core

2. Select from the standard print options in the usual way.

3. If you are printing to a black and white printer, select the Print Redline in black
and white checkbox, as color text may not appear clearly when printing in black
and white.

4. If you only want to print pages of the Redline that include changes, select the
Only print pages with changes checkbox.

5. Click OK.

Note: You can preview the printed version of the Redline, original or modified
document using the Print Preview options in the File menu.
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Converting Redline to PDF

You can convert the Redline to PDF and save it locally or in your DMS or you can
attach the PDF to an email and send.

To convert a Redline to PDF:

1. Click PDF in the Home tab. The Convert to PDF dialog is displayed.

Workshare Protect - Convert to PDF >

(=) Workshare

Convertyour document to PDF and configure its security options.

Save document as:
(@) PDF (.pdf) Optimized For everydsy ussge

(O POF/A (.pdf)  Optimized for archiving

Configure POF Security

Select pages to include:

@ Al

Enterpagenumberand/orpageranges
Fages
O Pag separated by commas (e.g. 2, 5-8)

View and send
(@ Mone
(") Open PDF once created

(") Email PDF as attachment

Help Preview Create Cancel

Note: This dialog displays slightly differently depending on whether you are
working with a document saved in your DMS/CRM.

2. Select whether you want to convert the Redline to PDF or PDF/A.
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3. If required, click Configure PDF Security to set PDF security options as well as
metadata cleaning options. The following dialog is displayed.

Workshare Protect *

PDF security configuration

[] Prevent printing

[] Prevent editing of text

[] Preventthecopying of textand/or graphics
[] Prevent comments being added

Metadata cleaning

Cleaning Options 0 option{s) selected

Password protection

Specify a password forthe generated PDF. Only users with the
password can openthe document.

|Speciﬁ.f password |

|Cu:unﬁrm password |

Cancel

4. If you selected PDF, you can select one or more of the security options as

required:

= Prevent printing: Prevents recipients from printing the PDF document.

= Prevent editing of text: Prevents recipients with Adobe Distiller from editing
the PDF document.

o Prevent the copying of text and/or graphics: Prevents recipients from
copying graphics or text directly from the PDF document.

o Prevent comments being added: Prevents recipients with Adobe Distiller
from adding comments to the PDF document.
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5. If you selected PDF or PDF/A, click Cleaning Options to specify what metadata
to remove before converting the Redline to PDF.

Workshare Protect *

Advanced Options

Choose the hidden data elements you would like deaned in the selected
documents:

=[] Risk Elements

----- O Accept changes and turn off Track Changes (Word and Excel)
----- O convert attached template to Mormal (Word)
----- O convert field codes to text (Office)

----- O elete built-in properties (Office)

----- O celete comments (Office)

----- O belete custom properties (Office)

----- O celete document variables (Word)

----- O pelete hidden text {Word)

----- O pelete routing slip (Word and Excel 2003)

----- O celete Smart Tags (Word 2003,/2007)

----- [ celete text smaller than Spt (Word)

----- O celete versions (Word 2003)

----- [ celete white text on white background {Word)
----- O Turn off versioning {Word 2003)

Help oK Cancel

6. Select metadata elements as required.
7. Click OK.

8. If you selected PDF, you can set a password to protect the PDF by entering the
password twice in the Password protection area. When a password is
specified, the recipient can only open the PDF after entering this password.

9. Click Apply.

10. In the Convert to PDF dialog, when working with a DMS, select whether to save
the PDF as a new document or as a related document or locally.
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11. If you want to create a PDF of part of the Redline only, select the Pages radio
button and specify a page range.

Note: You can also PDF individual pages by specifying the pages (separated
by commas) in the Pages field.

12. If required, click Preview to view the document as a PDF.

13. To open the PDF once it has been created, select the Open PDF once created
checkbox.

14. To attach the PDF to a new email message once it has been created, select the
Email PDF as an attachment checkbox.

15. Click Create. The Save as dialog is displayed.

16. Specify the name and location for the PDF file and click Save. The Redline is
converted to PDF.

69



Comparing Presentations

Chapter 3. Comparing Presentations

This chapter describes Workshare Compare for PowerPoint, a standalone application
that enables you to compare two or more presentations. It includes the following
sections:

e Introducing Compare for PowerPoint, page 71, introduces the Workshare
Compare for PowerPoint application and explains how to launch it.

e Comparing Presentations, page 72, describes how to compare a presentation
against an earlier version of the presentation or against a different presentation
using Workshare Compare for PowerPoint.

o Workshare Compare for PowerPoint Main Window, page 75, describes the
Workshare Compare for PowerPoint environment and provides an overview of
the functionality available.

o Working with Comparisons, page 81, describes the tools available to you
when working with the compared presentation after a comparison.
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Introducing Compare for PowerPoint

Note: This chapter describes how to compare PowerPoint presentations. The
comparison of Word documents and PDF files is described in Chapter 2.

Workshare Compare for PowerPoint is a presentation comparison tool designed to
make the process of editing and revising presentations as fast and efficient as possible.
Workshare Compare for PowerPoint enables you to compare Microsoft PowerPoint
presentations and immediately see any differences between them. In one view, you can
see both the original and modified presentations with the differences clearly marked as
well as a written summary of the changes and color-coded thumbnails of the slides
showing which slides were modified, deleted, and inserted. Presentations stored in your
DMS or CRM, locally or on your network can be compared.

To make the review easier, you can select different “comparison themes” to define
exactly what is compared as well as how changes are displayed.

What is compared?

Workshare Compare for PowerPoint provides a comprehensive comparison of two
Microsoft PowerPoint presentations and can detect the following changes:

e Slide moves, insertions and deletions
e Text moves, insertions and deletions
o Text formatting changes

e Image and object content changes

e Text box changes

e Hyperlink changes

e Speaker note changes

e Slide background changes

Launching Workshare Compare for PowerPoint

The Workshare Compare for PowerPoint application can be accessed in the following
ways:

e Double-click the Workshare Compare for PowerPoint icon on the desktop.

e From the Start menu, select Programs, Workshare, Workshare Compare for
PowerPoint.

e Within Microsoft PowerPoaint, click Compare in the Workshare tab.
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¢ Right-click a closed Microsoft PowerPoint document (locally or in your DMS) and
select Compare with Workshare.

In each case, the Select Presentations for Comparison dialog is displayed from where
you can select which presentations to compare.

Comparing Presentations

You can compare your original presentation against a previous version of the
presentation or against another presentation entirely.

To compare presentations:

1. Double-click the Workshare Compare for PowerPoint desktop icon or from the
Start menu, select Programs > Workshare > Workshare Compare for
PowerPoint. The Select Presentations for Comparison dialog is displayed:

0 Select Presentations for Comparison >

(=) Workshare

Select the presentations that you would like to compare.

Original Presentation:

ckgroundiSample PPTs\Sample_presentation_version_1.pptc ~

Modified Presentation:
ckgroundiSample PPTs\Sample_presentation_version_2.pptc ~

Select Comparison Theme:
Detect All Changes v | =

This comparnison theme will find 2l detectable changes.

Help Compare Cancel

Note: Click Cancel if you want to close the Select Presentations for
Comparison dialog without running a comparison. For example, if you just want
to open the Workshare Compare for PowerPoint window in order to open a
previously saved comparison.
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2. Select the original presentation you want to compare by clicking the Open =
button to the right of the Original Presentation field.

3. Navigate to the document in your local file system, SharePoint or DMS/CRM and
click Open. The selected presentation is displayed in the Original Presentation
field.

Tip! If you want to compare a recently used file, click the dropdown '/ in the
Original Presentation and Modified Presentation fields and select the
presentations you want to compare. These lists contain the last 8 files you have
used.

4. Select the document you want to compare with the original presentation by

=

=

clicking the Open button to the right of the Modified Presentation field.

5. Navigate to the document in your local file system, SharePoint or DMS/CRM and
click Open. The selected presentation is displayed in the Modified
Presentation field.

Tip! To swap the original and modified presentations, click e .

6. From the Select Comparison Theme dropdown list, select the comparison
theme you want to use. Comparison themes contain a set of parameters that
define exactly what is compared as well as how changes are displayed. You can
select from the standard comparison themes provided with Workshare Compare
for PowerPoint or you can create and customize your own comparison themes.
Refer to Introducing Comparison Themes for further information.

Note: Clicking = to the right of the Select Comparison Theme field displays
the Comparison Themes Manager where you can create, modify and delete
comparison themes. For a full description refer to Appendix B: Configuring
Comparison Themes.

7. Click OK. The comparison process is launched and a progress dialog is
displayed.

When the comparison is complete, the Workshare Compare for PowerPoint window is
displayed showing the changes between the selected presentations. For a full
description of the Workshare Compare for PowerPoint interface, refer to Workshare
Compare for PowerPoint Main Window. For a description of how to navigate between
the changes and review the changes in your compared presentations, refer to Working
with Comparisons.
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Workshare Compare for PowerPoint from the command line

Comparisons can be run from the command line. Running DeckCompare.exe /?
displays a summary of the available command line options when the program starts up.

Waorkshare Compare for PowerPoint >
I--""_"\-.I Parameters:
L. 4 4 fload <comparison filex>

foriginal <presentation file>
fmaodified <presentation file>
ftheme <comparison theme name:>
[save <comparison file>

[report <pdf report file name:>
[showselector

[resetwindowlayout

/noapply

Examples:
DeckCompare.exe /load "ch\savedComparison.wpf"

DeckCompare.exe foriginal "c:\original. ppt”
fmaodified "c\modified. ppt"
ftheme "Detect All Changes"
fsave "chsavedComparison.wpf"

________________________________ oK
The command line parameters are as follows:
Parameter Definition
/load <file> Loads an existing comparison file (*.wpf).
/original <file> Selects an existing original presentation file for comparison.
/modified <file> Selects an existing modified presentation file for comparison.
/theme <name> Selects the named Comparison Theme.
/save<file> For an initial comparison from the command line, specifies a

file to save the comparison to.

Ireport <file name>  Creates a report of the comparison that includes the original
and modified slide as well as a list of the changes per slide
pair.

/showselector Displays the Select Presentations for Comparison dialog
enabling you to perform a new comparison.

Iresetwindowlayout Displays the main window in its default layout.
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ctionality for the comparison.

Parameter Definition
/noapply Turns off the Apply Change fun
1? Shows the command line options.

If /load is used, or both /original and /modified, the Select Presentations for Comparison
dialog is bypassed. Otherwise, the dialog is pre-populated with whichever of /original,

/modified and /theme are specified.

Workshare Compare for PowerPoint Main

Window

The Workshare Compare for PowerPoint main window enables you to view the results
of a comparison between an original presentation and a modified presentation. You can
view (in one work area) both source presentations, slide thumbnails and a summary of

the changes between the two source presentations.

File Menu Slide Selector Area

More Tab Home Tab Slide View Area

Change Summary Area

o

Sample_presentation_version_2.pptx tgainst Sample_presentation_version_1.pptx - Workshare Compare for PowverPoint

Comparison Themes

HOME = MURE
< =Y — = =
W] = e ] "
=h M= = & ®
New Print Create Show Change Current Shide Find Mext *l Last
Change . | Summary anly Change
Comparison Reports Change Mavigation
Slide Selector - B x Orniginal ; Sample_presentation_version 1 (shde 1) = X
Qriginal slides  Modified slides
STt ok Workshare Demo
9 Shewine how the redaction tool mi
E] m Chdalees §, 2008
ide 11 Change Summary

@ | Shide Number Change Mumbers Type
g 1-2 Replaced text
B n 3-4 Replaced text

Moved from shide | = e & .

13 * 5 Slide meove sourc
F 2 & Slide move destii

Fx 33 T Deleted text
F§ 44 89 Replaced text

Select Edit

Modified : Sample_pre: entation_version_2 (shde 1~ X

Workshare Demo
Shows how the redaction ool migh

30 Sepiember, 2008

X

Details
Cetobert30 September, 208
Shawandgshows how the redaction tool might wark

EsecutsseSUmmary

[ {95 A et e X

e

The ribbon changes according to the selected tab. In the above example, the Home tab

is selected so the Home ribbon is displayed.
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The different areas of the Workshare Compare for PowerPoint work area are described
in the following sections.

File menu
The File menu includes the following options:
Option Description
Open Enables you to open a saved comparison.

Comparisons are saved as Workshare
wpf files. Refer to Opening saved
Workshare Compare for PowerPoint files.

Save Enables you to save the current
comparison. Refer to Saving
comparisons.

Save As Enables you to save a saved comparison

with a new name.

Print Enables you to print a comparison report
showing the changes found by the
comparison. Refer to Printing comparison

reports.
About Displays version information about
Workshare Compare for PowerPoint.
Exit Closes Workshare Compare for
PowerPoint.

Quick access toolbar

The quick access toolbar provides one-click access to functionality. By default, the
Save and New buttons are available. Clicking the arrow to the right of the quick access
toolbar displays a menu with the following options:

Option Description

Reset Layout Displays the main window in its default layout with the Slide
Selector area on the left, the Slide View area on the top
right and the Change Summary area on the bottom right.

Minimize the Ribbon Hides the ribbon.

Note: To change the commands that appear in the quick access toolbar, right-click in
the ribbon and select Customize Quick Access Toolbar.
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Home tab

The Home ribbon enables you to move between slides and changes, as well as apply
and edit comparison themes.

HOME MORE 7
sl E1E] |
3 = — g © O

EE =
MNew Print Create Show Change Current Slide  Find Mext
Change

Changes Summary Only

Select  Edit

=p| Last

Comparison

Repaorts

Change MNavigation Comparison Themes

The options are described in the following table.

Section Option Description
Comparison New Opens the Select Presentations for Comparison
dialog enabling you to perform a new comparison.
Refer to Comparing Presentations.
Reports Print Enables you to print a comparison report showing
the changes found by the comparison. Refer to
Printing comparison reports.
Create Enables you to create a comparison report showing
the changes found by the comparison. Refer to
Creating comparison reports.
Change Show Displays only slides that include changes, hiding
Navigation  Changes those slides that have not changed.
Change Displays/hides the Change Summary area. Refer to
Summary Change Summary area.

Current Slide
Only

Find Change

Previous

Next

First

Displays only changes relating to the currently
displayed slide in the Change Summary area.

Enables you to search for specific text in the Change
Summary area. Refer to Searching changes.

Navigates to the previous change in the Change
Summary area. The change in also highlighted in the
Slide View area. Refer to Navigating between
changes.

Navigates to the next change in the Change
Summary area. The change in also highlighted in the
Slide View area. Refer to Navigating between
changes.

Navigates to the first change in the Change
Summary area. The change in also highlighted in the
Slide View area. Refer to Navigating between
changes.
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Section Option Description

Last Navigates to the last change in the Change
Summary area. The change in also highlighted in the
Slide View area. Refer to Navigating between

changes.
Comparison Select Enables you to select an alternative comparison
Themes theme from the dropdown list. This comparison

theme is then applied to the current comparison.
Refer to Applying Comparison Themes.

Edit Opens the Comparison Themes Manager from
where you can modify existing comparison themes
as well as create new comparison themes. Refer to
Customizing Comparison Themes.

More tab

The More ribbon enables you to change the display of the different areas in the main
window.

FILE HOME = MORE L 7]

& == F o= Q@

Swap Horizontal Wertical Tabbed Zoom Fit
Width

Criginal / Modified Slide / Views Zoom

The options are described in the following table.

Section Option Description

Original/ Swap Swaps the original and modified presentations and re-

Modified runs the comparison. Refer to Swapping the source
files.

Slide/Views  Horizontal  Displays the original and modified presentations side by
side in the Slide View area.

Vertical Displays the original presentation above the modified
presentation in the Slide View area.

Tabbed Displays the original and modified presentations in tabs
in the Slide View area.
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Section Option Description

Zoom Zoom Enables you to change the magnification of the original
and modified presentations in the Slide View area.
There are also zoom controls on the right side of the
status bar.

Fit Width Fits the original and modified presentations to the width
of the Slide View area.

Slide Selector area

The Slide Selector area displays thumbnail images of the slides in the original and
modified presentations. The slides have different colored borders so you can see at a
glance when a new slide has been inserted or a slide has been deleted or includes
changes. The border colors are as follows:

Yellow The content of the slide has changed.

Green  The slide has moved its position (the new position is indicated).
Red The slide has been deleted.

Blue The slide is a new inserted slide.

Slides that have not changed in any way have no colored border.

In addition, the following icons in between the slide pairs indicate which slide pairs are
different and which are the same:

© Both slides in the slide pair are the same.
W There are differences between the slides in the slide pair.

The slides currently selected in the Slide Selector area are displayed in the Slide View
area.

The Slide Selector area is by default positioned down the left side of the Workshare
Compare for PowerPoint environment. It can also float over the other windows. Click
the ‘= and select from the following options:

Ay Tip! You can also use the & to auto-hide the Slide
Dockable Selector area.

Tabbed Document

Auto Hide

Hide
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Slide View area

The Slide View area displays both presentations that have been compared and clearly
indicates the changes on each. The presentations are synchronized so that if you select
a particular slide in the Slide Selector area or a particular change in the Change
Summary area then that slide or change is shown in both the original and modified
presentations.

Changes are marked according to the comparison theme applied to the comparison.

For example, deleted text could be red-and-struck-through and added text could be blue
and underlined.

Change Summary area

The Change Summary area provides a list of all the changes between the original and
modified presentations in the order that they occur. Changes can be displayed for all
slides or on a slide by slide basis. Selecting a change in the Change Summary area
displays the slides that include the change in the Slide View area and highlights the
slides in the Slide Selector area. The change that is selected is highlighted in light
green in the Slide View area.

The color and formatting of the change in the Change Summary area and in the Slide
View area is determined by the comparison theme applied to the comparison. For a full
description of comparison themes, refer to Introducing Comparison Themes.

You can select changes in the Change Summary area using the mouse or using
buttons in the Home tab.

The following information is shown for each change in the Change Summary area:

Slide Number  The number of the original slide and the number of the modified slide
in the comparison.

Change The number of the change in the comparison. A change may have

Numbers two numbers when it includes two actions. For example, a deletion
and an addition.

Type The type of change, such as replaced text, deleted text box, moved
slide.

Details Details of the change.

The icons to the left of each change indicate the type of change as follows:

=% Replacements AT Formatting changes
=%+ |nsertions ‘% slide move source
=x Deletions ¥ slide move destination
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The Change Summary area is by default positioned across the bottom of the
Workshare Comparz.for PowerPoint environment. It can also float over the other
windows. Click the  and select from the following options:

Fring Tip! You can also use the # to auto-hide the Change
Dockable Summary area.

Tabbed Document

Auto Hide

Hide

Working with Comparisons

Navigating changes

After performing a comparison, you can review the result of the comparison and
consider the changes between the original and modified presentations. You can move
between changes by navigating between slides or by navigating between changes. All
areas of the Workshare Compare for PowerPoint window are synchronized.

Navigating between slides

Clicking slides in the Slide Selector area displays the selected slides in the Slide View
area and shows the changes relating to that slide in the Change Summary area.

Slide Selector - x Original : Sample_presentation_version_1 [slide 3} - X Modified : Sample_presentation_version_2 (slide 3) - X
Original slides  Modified slides | Exeedtive Summary Summary
Moved to slide 11 Change Summary -0 x
Slide Number Change Numbers Type Details
= 2 ] Slide move destil
= 33 7 Deleted text Executive Summary
Moved from slide e . . .
13 sh 44 8-9 Replaced text 5E - 4 bele e Gkl

unite some of the best blessings of axisi srekhadived-near tw
little to dictrecs her§Shewas th gect of the twa-dadghters
father and had |  her cictar! H I ish

0 T S e ) eress

o therhad dicd tonl forhertah
R

The following icons in between the slide pair in the Slide Selector area indicate whether
the slide has changed or not:

©  The slide has not changed.
&  The slide has changed.
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In addition, the thumbnail images of the slides in the Slide Selector area have different
colored borders so you can see at a glance when a new slide has been inserted or a
slide has been deleted or a slide includes changes. The border colors are as follows:

Yellow The content of the slide has changed.

Green  The slide has moved its position (the new position is indicated).
Red The slide has been deleted.

Blue The slide is a new inserted slide.

Slides that have not changed in any way have no colored border.

Navigating between changes

Clicking a change in the Change Summary area displays the slides that include the
change in the Slide View area and highlights the slides in the Slide Selector area. The
change that is selected is highlighted in light green in the Slide View area.

The color and formatting of the change in the Change Summary area and in the Slide
View area is determined by the Comparison Theme applied to the comparison. For a
full description of Comparison Themes, refer to Introducing Comparison Themes.

Change Summary * 0O x
Slide Number Change Numbers Type Details

$ 6/6 15-16 Replaced text Scope & Approackapproach

AN 7T 17 Text Box Changed Mowved up and left
& 77 18-19 Replaced text Section 2 - Scope & Appreschapproach
+ 17 20 Inserted text ..conjunction with the paragraph on prospective financial infc

unless it is Thursday.

& a/8 21-22 Replaced text Section 32.1
& 99 23-24 Replaced table cell OtemporaorrerecTempus fugit
§ 99 25-26 Replaced text Section 32,1 - Detailed Finding

gy 27 Slide move destination

You can also move between changes in the Change Summary area using the First,
Last, Previous and Next buttons in the Change Navigation group of the Home tab.

Note: By default, the Change Summary area provides a list of all changes occurring
on all slides in the compared presentations. If you want to display just the changes
that occur on the displayed slide, click the Current Slide Only button in the Change
Navigation group of the Home tab.

The Change Summary area indicates the type of change as well as details of the
change itself, such as the specific text that has been inserted or deleted.
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Searching changes

You can search for specific text in the Change Summary area. Workshare Compare for
PowerPoint can search all text in the Change Summary area or just the text that has
been changed (inserted, deleted or moved).

To search changes:

1. Click the Find Change button in the Change Summary group of the Home tab.
The Find Changes dialog is displayed.

@ Find Changes >
Find what: -
[ ] Match case Search changed text only

Find Close

2. In the Find what field, enter the text that you want to look for.

3. Select the Match case checkbox if you want to search for identical text in the
same case.

4. Select the Search changed text only checkbox if you want to search only the
text that has been changed.

5. Click Find. Workshare Compare for PowerPoint searches for the specified text.
When it is found, the text is highlighted in the Change Summary area and the
relevant slide is shown in the Slide Selector area and Slide View area.

6. Click Find Next to search for further occurrences of the specified text. Click Find
Previous to return to the previously found instance.

7. Click Close to close the Find Changes dialog.
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Swapping the source files

You can re-run a comparison exchanging the original presentation for the modified
presentation and vice versa. For example, if you selected Presentation A as the original
presentation and Presentation B as the modified presentation, Workshare Compare for
PowerPoint shows the changes made to Presentation A to produce Presentation B. You
can then swap the presentations so that Presentation B is now the original and
Presentation A is the modified presentation. Workshare Compare for PowerPoint
automatically re-runs the comparison and shows the changes made to Presentation B
to produce Presentation A.

To swap the source presentations:

Click Swap in the More tab. Workshare Compare for PowerPoint automatically runs a
new comparison, using the modified presentation as the original presentation and the

original presentation as the modified presentation. The new comparison is displayed in
the Workshare Compare for PowerPoint window replacing the previous comparison.

Saving comparisons

You can save a comparison as a Workshare Compare for PowerPoint file (.wpf) in your
DMS or CRM, locally or on your network. This file type can be opened in Workshare
Compare for PowerPoint.

To save a comparison:

1. Click Save in the File menu or quick access toolbar. The Save As dialog is
displayed.

2. Navigate to the location where you want to save the file and enter a name for the
file.

3. Click Save.

Note: If you work with Workshare online, you can also use Save As and save the
comparison to your Workshare sync folder and it will be synchronized to Workshare
online. Refer to Adding files to Workshare.

Opening saved Workshare Compare for PowerPoint files

When a comparison has been saved as a Workshare Compare for PowerPoint file, you
can open it from the Workshare Compare for PowerPoint main window.

To open a saved comparison:

1. Click Open in the File menu. An Open dialog is displayed.
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Note: If Workshare Compare for PowerPoint is not open, launch it in the usual
way and click Cancel in the Select Presentations for Comparison dialog so that
no initial comparison is performed and a blank Workshare Compare for
PowerPoint main window is displayed.

2. Navigate to the location where the comparison is saved and select the .wpf file
you want to open.

3. Click Open. The selected comparison is opened in Workshare Compare for
PowerPoint.

Creating comparison reports

After you have run a comparison, you can create a report showing the changes found
by the comparison. The PDF comparison report can include both the original and
modified slides as well as a list of changes per slide pair or you can select to include
just the slide pair or just the list of changes.

To create a comparison report:

1. Click Create in the Home tab. The Create Comparison Report dialog is
displayed.

@ Create Comparison Report >

~Choose Report Layout

(@ Full Comparison Report e

Includes both eriginal and modified slides as well as
a list of changes per slide pair. Original

i) Change Summary On|
- " , ry Only ) Modified
Includes a list of changes in table format for each
slide pair.

Changes

() Slide View Only

Includes both eriginal and modified slides,

Exclude Unchanged Slides from Report

Preview Create Cancel

2. Inthe Choose Report Layout area, select what you want to include in the
report by selecting one of the following options:
= Full Comparison Report: Includes the original and modified slide as well as
a list of the changes per slide pair.

o Change Summary Only: Includes the list of changes in table format for
each slide pair.

o Slide View Only: Includes the original and modified slides.
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3. Select the Exclude Unchanged Slides from Report checkbox if you only want
to include slides with changes in the report.

Note: To display the selected comparison report, click Preview.

4. Click Create.
5. Inthe save dialog, browse to a save location and enter a name for the report.

6. Click Save. The comparison report is generated and saved as a PDF in the
specified location.

Printing comparison reports

After you have run a comparison, you can print a report showing the changes found by
the comparison. The comparison report can include both the original and modified
slides as well as a list of changes per slide pair or you can select to include just the
slide pair or just the list of changes.

If you have created a comparison report already and saved it as a PDF (as described in
Creating comparison reports) you can simply print the PDF in the usual way. The
following procedure describes how to create and print a comparison report in one step.

To print a comparison report:

1. Click Print in the Home tab or File menu. The Print Comparison Report dialog is
displayed.

2. Inthe Choose Report Layout area, select what you want to include in the
report by selecting one of the following options:

o Full Comparison Report: Includes the original and modified slide as well as
a list of the changes per slide pair.

o Change Summary Only: Includes the list of changes in table format for
each slide pair.

= Slide View Only: Includes the original and modified slides.

3. Select the Exclude Unchanged Slides from Report checkbox if you only want
to include slides with changes in the report.

4. In the Printer area, select which printer to use.
5. In the Print Range area, select whether to include all slides or selected slides.

6. In the Copies area, enter how many copies of the comparison report you want to
print and select the Collate checkbox if collating of multiple copies is required.

Note: To display the selected comparison report, click Preview. Note that the
full report is displayed for preview even if a page range has been specified.

7. Click OK. The comparison report is created and printed as specified.
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Chapter 4. Working Online

This chapter describes the Connect element of your installation which brings the online

secure file sharing, collaboration and storage features of Workshare to your desktop. It
includes the following sections:

e Qverview, page 88, introduces the online functionality available with Workshare.

e Syncing local files, page 88, describes how to use the Workshare desktop app
to sync content between your desktop and Workshare online.

e Getting content online, page 102, describes how to share files to Workshare
groups from open Office documents and using right-click options
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Overview

With File Share & Sync included in your installation, you can add your files to the
secure Workshare online platform. Once there, you can access your files from
anywhere and share them securely with people inside or outside your organization.

Workshare integrates with Windows Explorer so you can save and organize your files in
local folders that function seamlessly on your hard drive, but automatically synchronize
with Workshare online. Workshare also integrates with Office so you can share for
review, for example, from right inside Word.

Workshare is available online through a browser at my.workshare.com. Content is
divided into different areas to suit your needs:

Folders Use Folders to publish files and make them available to others.
Within Folders, use My Files to store your own private files that
you don’t want to share with anyone but you want easy access
to from anywhere.

Groups Use groups as workspaces where you can collaborate on files
with people inside and outside your company.

Workshare integrates its save and share functionality into your familiar working
environment:

e Using the Workshare sync folder on your desktop, you can save and share any
files to all areas of Workshare online

e From open Office documents, you can save files to My Files in Workshare and
share files into Workshare groups

e From your desktop, you can right click any file and share it to a group in
Workshare

In order to access and use Workshare online, you must have a Workshare account.

Syncing Local Files

The Workshare sync folder is your local access point to the online services of
Workshare. Both the Workshare sync folder and the synchronization functionality are
provided by the Workshare desktop app.
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What is the desktop app?

With File Share & Sync included in your installation, the Workshare desktop application
(the desktop app) is installed. This is an application that syncs content between
Workshare and your PC so you can access your files and continue collaborating from
your desktop while offline. The key features of the desktop app are as follows:

e Synchronization - Synchronizes groups, folders and files between Workshare
and your desktop. You can be selective about what is synchronized to reduce
the storage footprint on your local machine. If you can’t work online, as soon as
you're back online, the new versions are uploaded right away.

e Integration - Integrates Windows with Workshare online linking Workshare
directly to everyday applications — users can save files directly into the
Workshare sync folder from where they are copied into Workshare online.

Launching the desktop app for the first time

The desktop app is launched once the Workshare 9 installation is complete.

=) Warkshare - a x
file View Help

=) warkshare

CE] Workshare

Welcome, let’s get started

Enter your email address to sign in or register

| Email address ‘

25 Ssign in with Microsaft work account

Find outmore

Getyour files immediately onany device

The installation of the desktop program places an icon in your Windows taskbar for
basic management and it puts a folder in your Favorites section in Windows Explorer,
so you can quickly access and save your Workshare content. In order to access and
use the desktop app, you must log in to it. You only need to perform this login once; in
future the desktop app will launch automatically when Windows starts. You use your
Workshare login credentials to log into the desktop app.
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To log in to the desktop app for the first time:

o When the desktop app launches after installation, enter the email address and
password you used to sign up for Workshare and click Sign In.

Note: You can also display the login page by clicking the Workshare icon on
your desktop or selecting Programs > Workshare Desktop > Workshare from
the Start menu.

The Workshare desktop app looks very similar to Workshare online accessed from a
browser.

In fact, from the desktop app, you can do all the things you can do when logging into
Workshare online through a browser.

Once you have logged in:

e Your files and folders from your online Workshare account start to synchronize
to your local Workshare sync folder

e The desktop app icon appears in your system tray

Workshare sync folder

The Workshare sync folder is your local access point to your online Workshare content.
You can always find the latest copy of your Workshare files and you can add files to
Workshare via the sync folder. It appears in your Favorites folder and its default location
is C:\Users\[user name]\Workshare. You can change the location of the Workshare
sync folder in Preferences > Sync Settings, described on page 159.

You can also click Open Workshare Folder from the desktop app main window.

=) B + | Workshare-ElizabethMorris — O x
Home Share Wiew 0
=« 4 53 s Helen Sagal » Workshare-ElizabethMorris » w 0 Search Workshare-Eliz... @
# Ouick access - Mame a Date modified
B Desktop - {5 Folders 01/08/2016 10:48
; Downloads P {5 Group Files 01/08/2016 16:23
|£j Documents -
&= Pictures -
¢ Favorites -
All hands + talent show pictures
Update 7 ol e o

2items 1 item selected =
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In your Workshare sync folder, you will see all your synchronized Workshare files and
folders, grouped as follows:

o Folders: Shows all your Workshare files and folders, including files you have
uploaded, as well as files others have shared with you. There are also three
default folders:

o My Files: Includes personal files that you don’t want to share.

o Received: Includes all the files sent to you by secure file transfer from
Outlook.

o Sent Files: Includes all the files you sent out to others by secure file transfer
from Outlook.

e Group Files: Includes all your Workshare groups which are flexible workspaces
ideal for projects that require dynamic conversations.

If you add, update or delete a file in your Workshare sync folder, it will be added,
updated or deleted in Workshare online too. Similarly, if you add, update or delete a file
in a synced folder in Workshare online through the web app on a browser, the changes
will be seen in the Workshare sync folder.

The icon to the left of a file/folder indicates its sync status:
515 Waiting to be synchronized or synchronization is in progress
S Synchronized

In this two-way file synchronization, updated files are copied in both directions, usually
with the purpose of keeping the two locations identical to each other. You can control
what is synced from your desktop just by adding or replacing files in your Workshare
sync folder. Careful, though because anything you remove from your Workshare sync
folder will also be removed from your Workshare online content.
Default sync
By default, the following files are synchronized:

e Files you add to My Files

¢ Files you add to a shared folder or a group that you own

o Files others add to a shared folder or a group that you own

You can select which folders to sync using the selective sync option. Refer to Selective
synchronization.
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The desktop app system tray icon shows the status of the desktop app as follows:

Ilcon Status
ﬂ] Synced
" Sync
m progress
fz'z;-__] Pause
ﬁ] Conflict

; Upgrade
@ U

F:-:J Offline

in

Description

The files in your local Workshare desktop folder are fully
synced you're your online Workshare content.

The files in your local Workshare desktop folder are
currently syncing with your online Workshare content.

Synchronization between your local Workshare desktop
folder and your online Workshare content is currently
paused.

There is a conflict between files in your local Workshare
desktop folder and files in your online Workshare content.

An upgrade is available for the Workshare desktop app.

The desktop app has been placed offline so no
synchronization can occur.

Clicking the icon displays the following options:

Option

Open Workshare
App

Open Workshare
folder

Files up to
date/conflicts
Pause
Refresh
Recycle Bin

Selective Sync

Preferences

Help and support

Description

Opens the Workshare desktop app window.

Opens the Workshare sync folder.

Indicates that all files are synchronized successfully or if there
are sync conflicts between the desktop app and Workshare.

Pauses the current synchronization. The option becomes
Resume Syncing when synchronization is paused.

Refreshes the display and synchronizes with Workshare
online.

Displays the Workshare recycle bin which includes all the
Workshare files, folders and groups that have been deleted.

Enables you to select which folders are synchronized between
your desktop and Workshare online.

Enables you to change application settings for the desktop
app, such as the location of the sync folder or general account
settings.

Provides access to the Workshare knowledge base.
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Option Description

Quit Workshare Stops the synchronization between your desktop and
Workshare online.

Adding files to Workshare via the sync folder

You can add most file types to your local Workshare sync folder which will then be
synchronized with your Workshare online account. You can add files to existing groups
or folders or create new folders. You cannot create new groups from within the sync
folder.

Note: Groups are created in Workshare from the web app or the desktop app.

You can simply copy/paste or save files into your local Workshare sync folder and they
will be synchronized to Workshare online by default. However, if you have selected that
specific folders do not synchronize then files added to those folders will not be
synchronized. Refer to Selective synchronization.

To copy/paste to your local Workshare sync folder:

Drag the files or folders you want to add into your local Workshare sync folder.

| [+ + | Matter 77 - Romeo v Juliet - O X
Home Share View 9

&« v <« Folders » Matter 77 - Romeo v Juliet v | Search Matter 77 - Ro... @
w [ Workshare-ElizabethMorris ~ Mame . Date modified Type
v @) Folders &/ Emails 26/07/201609:42  File folder
@/ 01039697 - GoodSmith, Gregg & U 5 FAQs - Deployment Options WHS.docx 26/07/2016 09:38 Microsoft Word
@ Ainsley's folder for cool people 5 WS Connect - Mew Feature.doc 26/07/20 Microsoft Word
@ All hands + talent show pictures 65 W5 Hybrid Storage Installation Guide.docx 26 Microsoft Word
@ Blood Samples
@ Documents
@  Draft Guides
@ Getting Started 1
@ Inbox
@ Letters W
@ Limited Editions
> @ Matter 77 - Romeo v Juliet |—> Move to Matter 77 - Romeo v Juliet |
@ My Files
v < >

(S O N N -

4 items =
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To save files to the Workshare sync folder:

1. Open afile — this can be any file, for example, a Word file, a PowerPoint
presentation or an image file.

2. Click Save As.

3. Browse to your Workshare sync folder in Favorites. By default this folder is
located at Users\[user name]\Workshare.

4. Browse to a location in any of the 3 areas in Workshare and select an existing
folder or create a new folder.

5. Click Save. Your file is now saved in your local Workshare sync folder and it is
immediately synchronized to Workshare online (unless the selected folder is not
set to synchronize).

Files won't sync from here...

o Files added to the top level “Workshare” folder in your local sync folder will not
be synchronized. Files must be added into one of the three areas of Workshare
— Files & Folders (Classic), Group Files or My Files.

¢ New folders added to the Group Files area will not be synchronized — Groups
can only be created via the web app.

E i

In either of the above scenarios, the icon next to the file &= and a popup message alert
you that the file/folder cannot synchronize to Workshare.

Your file is not placed in a folder that syncs to
= ' Workshare

Move it to a group folder or 'My Files' to syncit.

View

Clicking View opens the non-syncing folder locally so you address the problem.

94



Working Online

Restoring deleted files

From the desktop app, you can access the Workshare online recycle bin where you can
restore any of your accidentally deleted files, folders or groups. The recycle bin lists all
your Workshare files and folders (those you own) that have been deleted — you may
have deleted them using a Web browser, from the desktop app or directly from the
Workshare sync folder.

Note: When you have deleted files and folders from the desktop app or the
Workshare sync folder, you will only see the deleted files and folders in the recycle

bin after synchronization.

The desktop app provides a window into the Workshare online recycle bin so if you are
offline, you will not be able to access the recycle bin.

To access the recycle bin:

Click Recycle Bin in the left panel.

5] Workshare — O x
File ¥iew Help
. e
Search Q [ Open Workshare Folder Elizabeth Morris I‘L’I v
. MINTON
Recycle Bin DRESDEN

Deleted files and folders STAFFORD

Restore All Empty Recycle Bin

Show Me
MName A Parent folder Deleted by Owned By Deletion date
% Deleted by me
] i i i v
Deleted by everyone else 1| Sample Original Document.docx  Release Notes Elizabeth Elizabeth 1 year ago
|| WorkshareSocial-debug (2).apk A Elizabeth... Elizabeth... 2 years ago

B | WS Compare 8 Release Notes. Release Notes Elizabeth... Elizabeth... 2 years ago
B | WS Protect 8 Release Notes.d... Release Notes Elizabeth... Elizabeth... 2 years ago

&)

In the recycle bin you can see:
o Files, folders and groups owned by you that have been deleted by anyone; and
o Files, folders and groups owned by anyone that have been deleted by you.

. You can filter the list to see what was deleted by you and what was deleted by others.

e Click Restore All to restore all files and folders in the recycle bin back to their
original location.

e Click Empty Recycle Bin to permanently delete all files and folders in the
recycle bin.
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To restore selected files:
1. Click Recycle Bin in the left panel.

2. Select a file or a folder (or several files and folders). The buttons change to
Restore Selected and Empty Selected.

) MINTON
Recycle Bin DRESDEN
Deleted files and folders STAFFORD

Restore Selected Empty Selected

MName A Farent folder Deleted by Owned By Deletion date

Show Me
® Deleted by me

[ igi i i \
Deleled by everyone else ¥ 1 | Sample Original Document. docx ~ Release Notes  Elizabeth Elizabeth 1 year ago

v || WorkshareSocial-debug (2).apk Elizabeth ... Elizabeth... 2 years ago
B | WS Compare 8 Release Notes.... Release Notes Elizabeth ... Elizabeth... 2 years ago
B | WS Protect 8 Release Notes.d... Release Notes Elizabeth ... Elizabeth... 2 years ago

o

3. Click Restore Selected to restore the selected folders and files.

File synchronization

The desktop app synchronizes your online Workshare content to your PC so you can
access your files and continue collaborating when offline. By default, the following files
are synchronized:

o Files you add to My Files
e Files you add to a shared folder or a group that you own
e Files others add to a shared folder or a group that you own

So if you add any of these files to Workshare via a web browser, they will be synced to
your desktop and you will be able to access them from the Workshare desktop app (or
sync folder). Synchronization works both ways so if you delete any of these files from
the Workshare desktop app (or sync folder), they will be deleted from Workshare online
and you will no longer be able to access them via a web browser.
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Synchronization between Workshare online and your desktop occurs in the following
situations:

¢ When logging into the desktop app

o When a new event occurs on Workshare online, such as a new file uploaded or
a new version added

¢ When a new event occurs in the Workshare desktop app (or sync folder), such
as a new folder created or a file added

e When the desktop app has been offline and then you go back online
¢ When clicking Refresh in the desktop app system tray menu
¢ When clicking Update and Sync in the Selective Sync page

You can pause synchronization at any time, for example, if you have a slow connection,
and then restart it when convenient.

To pause synchronization:
Click the desktop app system tray icon and select Pause. Synchronization stops.

To restart synchronization, click the desktop app system tray icon and select Resume.

Selective synchronization

You can maodify the default synchronization settings so that less files and folders are
synchronized to your desktop in order to reduce the storage footprint on your local
machine.

To select folders to synchronize:

1. Click the desktop app system tray icon and select Selective Sync or from the
File menu in the desktop app main window, select Selective Sync. The
selective sync page is displayed showing the root folders on Workshare —
Folders and Group Files.

2. Click a folder to display its subfolders.

3. Select the folders that you want to synchronize between Workshare and your
desktop by selecting the checkbox to the left of the folder/subfolder name.
Selecting or deselecting a folder will automatically select/deselect the subfolders
belonging to the folder. However, you can select a folder but then manually
deselect some of its subfolders. Use the Select All checkbox to quickly
select/deselect all folders.

Note: By default when a folder or group is shared with you it is selected for
synchronization. To change this, deselect the Automatically sync new folders
shared with me checkbox.
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4. Click Update and Sync. All folders with a selected checkbox will be
synchronized. The progress of the synchronization is shown in the sync
progress page.

Folders that are not synchronized will not appear in your local Workshare sync folder.

Sync progress
The sync progress page shows the folders and files currently being synchronized.
To display the sync progress page:

When synchronization is in progress, select Sync Progress from the View menu.

(=) Workshare Sync Progress — O =
User name, file name, type or folder = (&) 'u'
Name Folder Size Progress Last Updated By ™
@ ShutdownService.html Server 10 KB l 2l | Michael Ward
Downipad Completed
@ SMTPMessage.html class-use 10 KB l 2l | Michael Ward
Downipad Completed
@ package-use.html general 9 KB l 2l | Michael Ward
Downipad Completed
@ SynergyDemo.html Synergy 9 KB l 2l | Michael Ward
Downipad Completed
@ SynergyDemo.html Synergy 9 KB l 2l | Michael Ward
Downipad Completed
@ InvalidAddressException.html class-use 9 KB l 2l | Michael Ward
Downipad Completed
@ help-doc.html apidocs 9 KB l 2l | Michael Ward
Downipad Completed
@ Message.html class-use S KB l 2l | Michael Ward
EE  Worksharelnstal.exe WP4 SR-1 Build 8147 60 MB 5 Michael Ward
20% ]
[ worksharelnterwoven.exe 8177 57 MB Michael Ward
[ worksharelnstal.exe Workshare 4 - RC1 57 MB - 0% ' Michael Ward
Waiting fo sync
ﬁl WorkshareLondonSymbols.msi Build 6711 50 MB - Lz ' Michael Ward
Waiting fo sync
ﬁl WorkshareLondonSymbols.msi Build 6702 50 MB Lz ' Michael Ward v
< >
5 Syncing - 827 files remaining

The status bar provides a summary of the sync situation and the sync progress report
provides a detailed view.

The files being synchronized are shown in a queue format. If you want to move a file in
the queue, for example, you want to upload a small Word document and it is being held
up by a large PowerPoint presentation, right-click the file you want to delay and select
Lower the sync priority.
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Synchronization conflict

The sync conflicts page provides a dedicated area where you can deal with file
conflicts. Possible conflict scenarios include:

e You have opened a synced file locally and you are editing it. Meanwhile, in the
web app, a new version is added to the file. When you save the open file, a

conflict is shown.

o Two users are working offline and make changes to a file they share. User 1
goes back online and the revised file is synced to Workshare online as a new
version. User 2 goes back online and a conflict is shown.

In your local Workshare sync folder, the file icon shows there is a conflict:

6"_] Sample Changed Modified Document.do...
6"_] Sample Modified Document.docx
] Sample Original Document.docx

=
In addition, the desktop app system tray icon shows there is a conflict and the
menu includes a Conflicts option:

& Open Workshare App
= COpen Workshare folder

« Al files and folders are up to date

11 Hause

Refresh

(&}

Recycle Bin
Selective Sync...
Preferences...

Help and support

Cuit Workshare

0O OuRE
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To resolve a conflict:

1. Click the desktop app system tray icon and click Conflicts. The sync conflicts
page is displayed listing the files with conflicts.

2. Expand a file in the sync conflicts page by clicking o. The options for resolving
the conflict are displayed. For example, you may want to add your file as the
latest version or overwrite your version with the online version. You can always
opt to keep both files involved in the conflict. Different options are displayed
according to the particular conflict.

5 Sync Conflicts - X

Mame Owner Date of COI%hICt

£?| Sample Original Document.doc

Helen Sagal has updated this file while you were editing it.
How would you like to reseclve this?

@ Keep both (choose this option if you're not sure)

O Keep my version Size 80 KB Date modified. 16 May 2016 16:03

() Keep Helen Sagal's version Size 80 KB Date modified: 16 May 2016 16:04

Resolve

3. Select the option you want to apply and click Resolve.

Note: When there are no conflicts, the sync conflicts page is not available.
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Collaborating in Workshare

Once you have shared folders with other users, those users will be able to access
Workshare via the web app, view the files in the folder and add comments in real-time.
If they have permission, they could also add new versions to a file. Any new versions
will be synchronized to your desktop and you can also add versions to Workshare files
from your desktop through your Workshare desktop app or your local Workshare sync
folder. For example, simply open a file from your local Workshare sync folder, edit it and
save it and it will be synced to Workshare online and appear as a new version.

Ej Workshare

File View Help

Sample Original Document.doc

fdated just now by Elizabeth Morris

You can also open any file and save over a file in your local Workshare sync folder. It
will be synced to Workshare online and appear as a new version.
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Getting Content Online

As well as using your local Workshare sync folder to get your content online, you can
use the right-click options and toolbar options added by the Connect element of your

Professional installation.

Right-click sharing
The way to share files and folders from your desktop is to share them to a Workshare
group.

Right-clicking any file on your desktop provides the option to share it to a group. The file
or folder will be added to the group’s files and all members of the group will be able to

access it.
To share to a group:

1. In Windows Explorer, right-click any file or folder.

] Minutes 281 [2) Compare with Workshare hon File 08
& ND Modifief T Convert to PDF with Workshare h Text Format 04
®) ND Modifie 2 Combine files in Workshare Tent Errrnat q
21 o origing | TN <2 shareto group

2. Select Workshare, then Share to group.

15 Share to group =

This file will be shared with people in:

Enter group name|

—-  Sample Original Document. docx ﬁ
34KB
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3. Enter the name of the group you want to share the file/folder with. When you
click in the text box, a list of the most recent groups selected is displayed. As
you start to enter a name, groups are suggested to you.

This file will be shared with people in:

Review Material

Create a new group: Review Material

4. Select an existing group or enter a new group name and click Create a new
group.

Note: Click Change Group to remove the specified group so you can select
another one.

5. If you want to change the name of the file/folder you are sharing, click £z and

edit the name.

6. Click Share. The file/folder is uploaded to the specified group in Workshare
online. If the group is synced, the added file or folder will also appear in the
selected group in your local Workshare sync folder.

From open Office documents

Using Workshare toolbar options, you can save your Office files to Workshare online so
they will be accessible to you online at all times. You can save them directly to a folder
in My Files if they are private files that you don’t want to share with anyone or you can
save them directly to a group if you want to collaborate on them with people inside and
outside your company.

You can save Word, Excel and PowerPoint files in their native format or convert them to
PDF as you save.

Note: You can also save Redlines to Workshare online from within Workshare
Compare. Refer to Saving Redlines to Workshare online.

Additionally, you can display the Workshare Connect panel inside Office which provides
a window into the document you have shared to a Workshare group.
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Saving to My Files

The My Files area of Workshare online is where you can securely store your own
private files that you don’t want to share with anyone but you want easy access to from
anywhere.

To save documents to My Files:
1. Open afile in Microsoft Word, Excel or PowerPoint.

2. In the Workshare tab, click Save to My Files. The Save to My Files dialog is
displayed.

Note: If you are not already logged into Workshare, you may be asked to log in
before the Save to My Files dialog is displayed.

) Save to My Files — a >

&1 Create new folder

4 ® @® My Fies
O Work in Progress
O 550
)] Private
O Draft Contracts

File name: |Sample Original Document - Sample Modified

Save as type: | Adobe Acrobat File { *.pdf) v

Save Cancel

Tip! You can also display this dialog using Workshare options in the File menu.

3. Browse through My Files and select the folder where you want to save the file.
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Note: To create a new folder, click Create new folder, enter a name for the
folder and click Create.

4. In the File name field, modify the name of the file as required.

5. From the Save as type dropdown list, select the format for the saved file from
the following:

= Word Document/Excel Workbook/PowerPoint Presentation: Saves the
file in its native format

o PDF: Saves the file as a PDF file

o PDF/A: Saves the file as a PDF/A file

6. Click Save. The file is saved to the specified folder in Workshare My Files and
you can log into Workshare and access the file from anywhere. The following
notification pops up on your desktop:

’ File saved to Workshare
Copy link View

You can click View to open the file in Workshare in your browser or click Copy
link to copy the URL to the file to your clipboard. You can then paste this link to
another location, for example, an email or an instant message.

If the Workshare My Files folder is synced, the added file or folder will also appear in
your local Workshare sync folder

Once you have saved a file to My Files, you can continue working and making changes
as required. Clicking Save to My Files again will save the file to Workshare with the
same name and in the same location as a new version. If you want to save the file to
My Files as a new file with a different name, click the arrow on the Save to My Files
button and click Save as.
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Sharing to a Workshare group

By sharing files to Workshare groups, you save your file to a group in Workshare and all
members of that group can access your file and collaborate on it with you.

To share documents to a group:
1. Open afile in Microsoft Word, Excel or PowerPoint.

2. In the Workshare tab, click Share. The Share dialog is displayed.

Note: If you are not already logged into Workshare, you may be asked to log in
before the Share dialog is displayed.

Share *
®

A copy of your file will be shared to:

Enter group name

== WS Professional 9 UG &~ Version 1

Cancel

Tip! You can also display this dialog using Workshare options in the File menu.

3. Enter the name of the group you want to share the file with. As you start to enter
the name, groups are suggested to you.

A copy of your file will be shared to:

sun| (/)

Sunset Project Group

Vorkshare Ltd, 2 members

Create a new group: sun
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4. Select a group or enter a new group name and click Create a new group.
5. Edit the name of the document by clicking £ , modifying the name and then
clicking o

6. Click Share. The document is saved to the group in Workshare and a
confirmation dialog is displayed.

Share *
QS

©

File shared

A copy of Sample Original Document
has been shared in the folowing group:

Sunset Project Group l j

Link to file:
https://my.workshare.com/#groups/share/bc30933c-5d523-1126-9520-000d3ab0sbfd

If the Workshare group is synced, the added file or folder will also appear in your
local Workshare sync folder

7. Continue in one of the following ways:
= Click Send email to open a new email in Outlook that includes a link to the
document in Workshare. You can invite people to the group by sending the
email to them.
= Click Go to group to open the group in Workshare in your browser where
you can see the document, set group permissions and select members.

Note: Click to copy the link to the document to your clipboard. You can
then paste this link to another location, for example, an email or an instant
message.
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Monitoring shared files

The Workshare Connect panel inside Office provides a window into the files you have
shared to Workshare groups.

When you have shared a document into a group in Workshare and you open the
document locally, the Workshare Connect panel provides a view of what is happening
with your collaboration. You can see the other reviewers (the members of the group)
and whether they are online at the moment. You can also see how many comments
have been made on the document and whether any new versions have been added to
it. With a single click you can open the document in Workshare online via a browser
and join in the collaboration by viewing comments and making your own comments.

If you open a shared document in Office and the Workshare Connect panel is not
displayed, click Toggle Panel in the Workshare tab to display it. When the document is
not shared to a Workshare group, the panel will look something like this:

Workshare Connect v X

HC’J
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Once your document is shared, the Workshare Connect panel will provide real-time

information about the collaboration, like new comments and versions.

Click the version
dropdown to see
other versions of
the document. Click
a version to display
it in the Workshare
web app.

The Comments tab
shows the number
of comments made
on the displayed
version as well as
the total number on
all versions.

Click here to display
the document in the
Woarkshare web

app.

New versions

Workshare Connect

* X

A new version of this document is available. Download

Sample Modified Document..docx

Versionl «

Comments

Comments on this version

Total of 6 on this document

People

A new version has
been uploaded.
Click here to
download it.

The People tab
shows the members
of this group and
who is reviewing
and editing the
document.

When there are
comments you have
not yet read, click
this alert to display
the document in the
Workshare web app
S0 you can review
the comments.

When another group member adds a new version of the document, you are notified in
the Workshare Connect panel. Click Download and the new version is downloaded and
opened. Now the Workshare Connect panel will ask if you'd like to see what's different
between this new version and the previous version. With a single click, both versions

are compared in Workshare Compare.

Workshare Connect

Version1 =

Comments

Sample Original Document.docx

A This document has besen updated since you last
1‘.‘1 opened it. See changes

People
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Comments added

In the Comments tab, you can see the number of comments made on the version of
the file you are looking at (in orange) as well as the total number of comments on all
versions of the file. If you want to see the actual comment, click View online and open
the file in Workshare via a browser so you can view comments and update versions and
add comments if you want. When comments are made that you have not yet seen, click
the Unread comments alert and the file is opened in Workshare via a browser.

Group members

In the People tab, you can see all members of the group that have access to your
document. A green light indicates the member is currently viewing the file. The following
three lists are available:

e Everyone: All members who have access to the file
e Reviewers: Any member who has looked at the file

o Editor: A member who has looked at the file in Word (and had Professional 9
installed and the Connect panel turned on)
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Chapter 5. Advanced PDF Functionality

This chapter describes how to convert a PDF file to a Microsoft Word file. It includes the
following section:

e Converting PDF Files to Word Format, page 112, describes how to convert a
PDF document into Microsoft Word format.
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Converting PDF Files to Word Format

Note: This functionality is not available when Workshare Compare is installed in
Office 2013 environments (and above); they have this functionality built-in.

Workshare Compare provides accurate conversion of PDF files to Microsoft Word files
(PDF to DOC/DOCX format) preserving document formatting and page layout. This
functionality is available from within Microsoft Word and by right-clicking closed PDF
files on your desktop.

Converting a PDF document into Word format is useful if you want to edit the
document, as PDF documents cannot be edited as easily as Word documents.

Notes:
Workshare cannot convert secure PDFs, meaning PDF files with security settings
configured.

Scanned PDF files will not be converted to editable text — the content remains as an
image and cannot be edited.

To convert a PDF:

1. To convert a PDF document to DOC format:
= Right-click the closed PDF file and select Open in Word with Workshare.

= From Microsoft Word, click the Office Button/File menu and select Open.
Browse to the PDF file and click Open.
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The Open PDF in Word dialog is displayed.

r ™
Workshare - Open PDF in Word ﬁ

(=) Workshare

Please select the conversion method from the options below.

Preserves page layout, ARRAMGEMENT LE

columns, formatting, graphics .
and text flow. Intmdeeon Home
The Lead hbnager and the make
. other Managers (as defined in - whett
[ Continuous paragraph 2 below) authc
Detects the page layout and | nece:
columns butgi?y pr:serves Chapter Cire Howe
. . This amangement letter sats make
the formatting, graphics and out the scope and limitations  whett

text flow,

ARRANGEMEN"

dtrodecdion
The Lead WBnager and the
- other Managers (as defined in
. paragraph 2 below)

|2 w=s3a -+

L

2. Select a conversion method according to how much of the formatting and layout
you want to preserve and click OK. The PDF document is converted to Word

format and is opened in Microsoft Word.

Notes:
The name in the title bar will still include the PDF extension. However, the document

is in DOC/DOCX format.

When converting a PDF file to Word format, the display may vary according to the
type of PDF. The type of PDF means the software used to create the PDF file. For
example, Adobe, Amyuni, CutePDF, novaPDF, and so on.

You must save the document.
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Chapter 6. Configuring Workshare

This chapter describes the Workshare Configuration Manager. It includes the following
sections:

e Introducing the Workshare Configuration Manager, page 115, introduces the
Workshare configuration utility.

e Accessing the Workshare Configuration Manager, page 115, describes how
to access the Workshare Configuration Manager.

e Setting Parameters, page 117, describes how to set values for parameters in
the Workshare Configuration Manager.
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Introducing the Workshare Configuration
Manager

The Workshare Configuration Manager is a configuration utility that enables you to
configure Workshare and the way it behaves as well as modify the configuration of the
Client Default profile (via the parameters in the Protection category).

Note: A profile is a collection of policies. A policy is a set of parameters applied by
Workshare Protect when determining content risk.

Administrator Mode and User Mode

The Workshare Configuration Manager has two modes as follows:

e Administrator Mode: This mode is for administrators to make changes to the
default settings on the local machine. Settings made are saved in
HKEY_LOCAL_MACHINE in the Registry. As a user you will only have access
to Administrator mode if you have Administrator rights.

e User Mode: This mode is for users to make changes to the Workshare
configuration to suit their own personal preferences on the local machine. Other
users could log in and they would not have the same configuration settings.
Settings made are personal to the user and saved in HKEY_CURRENT_USER
in the Registry.

Note: Your system administrator may have restricted the rights of users to modify
configuration parameters by locking individual parameters so that users cannot
override the setting. If you have restricted access rights and have special
requirements for configuration, please speak to your system administrator.

Accessing the Workshare Configuration
Manager

The Workshare Configuration Manager can be accessed from within Microsoft Word or
from the Start menu.

To access the Workshare Configuration Manager from Microsoft Word:

¢ In Microsoft Word, click Options in the Workshare tab. The Workshare
Configuration Manager opens in User Mode.
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To access the Workshare Configuration Manager from the Start menu:

e From the Start menu, select All Programs > Workshare > Workshare
Configuration (User Mode). The Workshare Configuration Manager opens in

-@ Workshare Configuration Manager (User Mode) — O x
E :]Workshare Configuration Manager n I
Launch Administrator Mode #§
Options Rendering Set Manager My Products
* Reset All To Default || Hide options | cannot change figu ptions
bl ] g % = =5 E
p
. L, El
Protection \_Lg‘, L@ ﬁ | - 0
Administration Sharing Interactive Protect Remove Metadata Exclude Metadata Convert to PDF Compress as Zip
. Goa oo
‘Comparison Tr]?o'( L&q |
Q &
Administration User Interface Rendering Sets
Fa Goa_oal
General *59}' w'
i
Administration User Interface
=
Integrations CUJ
General
I J L
Help Workshare Configuration Manager | Build 3007102 | Copyright ©1993-2016 Workshare Ltd. % Workshare

Note: In User Mode, the state of the options reflects the settings in
HKEY CURRENT_USER in the Registry.

The configuration parameters for Workshare are grouped into categories and sub-
categories. Click a sub-category to display the parameters for that sub-category. The
different sub-categories and their parameters are described in a separate guide -
Workshare Configuration Options.

Searching parameters

If you know the name of a parameter (or part of its name) but not its location, you can
search the Workshare Configuration Manager using the search box on the top right.

custom

Protection

Exclude Metadata

Exclude specified custom properties
Remove Metadata

Delete custom properties (Office)
Interactive Protect

Delete custom properties (Office)
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Click the parameter in the results list and the relevant category and sub-category is
displayed in the Workshare Configuration Manager.

Setting Parameters

Most parameters in the Workshare Configuration Manager are set by selecting or
deselecting a checkbox. There are also some that require you to enter a value in a text
box.

To specify parameters:

1. In the Workshare Configuration Manager, select a category and then a sub-
category.

2. Set a value for a parameter by selecting or deselecting the checkbox, selecting
an option from a dropdown list or entering a value in a text box.

Default document open location
& Default email attachment format Portable Document Format (.pdf)
Default Redline save location
Default rendering set
[T Display document description as well as document ID
Display document selection dialog on startup
{71 Display Redline in page layout view e
Display source document labels

The & icon to the right of a parameter indicates that the parameter value has
been changed.

Note: When parameters have been locked by your administrator, the parameter
will be disabled and a lock symbol will appear to the left of the parameter. You
cannot change locked parameters.

3. Continue to select categories and sub-categories and specify parameters as
required.
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4. Click Apply to save your settings. A confirmation message is displayed once the
settings have been saved.

Workshare >
- Options applied, restart Office applications
i The options have been successfully applied for this user.,

Please restart all running Microsoft Office applications
to ensure that your changes take effect,

5. Click OK and restart all Microsoft Office applications.

Note: The different sub-categories and their parameters are described in the
Workshare Configuration Options guide.
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Appendix A. Configuring Rendering
Sets

This appendix describes how to configure rendering sets for Workshare Compare and
apply them to a comparison. It includes the following sections:

e Introducing Rendering Sets, page 120, introduces Workshare rendering sets
and describes how they determine the look of a Redline.

e Accessing the Rendering Sets Manager, page 121, describes how to access
the Workshare Rendering Sets Manager.

e Customizing Rendering Sets, page 124, describes how to create your own
rendering sets as well as modify and delete existing rendering sets.

e Rendering Set Parameters, page 125, provides a detailed description of all the
parameters included in rendering sets.
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Introducing Rendering Sets

Workshare Compare uses colors and different formats in the Redline to enable you to
see the changes that have been made to the documents.

For example, the following indications can be used:

o Deletions in red-with-a-strikethrough

e Insertions in bright blue with a double underline

e Moved or cut text in green-with-a-strikethrough

e Pasted (copied) text in green with a double underline

e Moved deletions in

The colors and formats adopted depend on the rendering set applied to the
comparison. Workshare Compare includes several different rendering sets that you can
apply as required or you can modify these rendering sets or create your own rendering
set.

Note: It is general practice that your system administrator will have been involved in
creating a set of standard rendering sets for your company to use and may have
restricted the rights of users to create, delete or modify their own rendering sets. If
you have restricted access rights and have special requirements for rendering sets,
please speak to your system administrator.

Where are rendering sets stored?

By default, rendering sets are stored in the following locations:

e The default rendering sets included with Compare are machine-wide rendering
sets and are stored in a shared documents folder at the following location: C:
Users > Public > Public Documents > Workshare > Rendering.

e Any further rendering sets created by users are personal rendering sets and are
stored in C: Users > (user name) > My Documents > Workshare > Rendering.
This can be changed by an administrator in the Default location rendering set
parameter in the Workshare Configuration Manager (Comparison >
Administration category).

You can store rendering sets at other locations but you must specify the location (or
locations) in the Additional locations for rendering sets parameter in the Workshare
Configuration Manager (Comparison > Administration category). Workshare
Compare looks in the two default locations (specified above) to create a list of the
possible rendering sets available and will also look in any additional locations specified
in this parameter.
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Applying rendering sets

You apply a rendering set to a comparison before the comparison is run and you can
also apply a rendering set at any time after a comparison has been performed.

To apply arendering set after the comparison has been run:
o Refer to Applying a different rendering set

e Refer to Changing the comparison options

Accessing the Rendering Sets Manager

The Rendering Sets Manager is accessible from the Workshare Configuration Manager,
from Workshare Compare and from the Workshare tab in Microsoft Office.

From the Workshare Configuration Manager

Access the Workshare Configuration Manager and select the Rendering Set Manager
tab.

m Workshare Configuration Manager (Administrator Mode) — O X

C ) Workshare Configuration Manager
Administrator Mode

Options Rendering Set Manager My Praducts

Rendering Set: [Standard ‘] [ Save As... ] [ Delete Search Rendering Options

Comparison Options COmparison Options Redline Preview
Select the document features to be compared.
Redline Options

Redline Rendering A Comparison Options
Allow Auto Retry
Detect List Numbering Changes
Detect Footnote/Endnote Numbering Changes

Compare Headers/Footers

Compare Footnotes

| Compare at Character Level

[T] Compare Numbers at Character Level

] Ignore Embedded Objects/Images

] Ignore Case Changes

] Ignore Text Boxes

] Ignore Field Codes

Compare field contents as text
] Ignore Tables

| Display comments in redline
[T] Detect Changes to Images

] Ignore auto list against manual number list changes

Help Warkshare Configuration Manager | Build 8.0.07102 | Copyright ©1902-2016 Workshars Ltd. [a\f\bmahare
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If you have permissions, you can modify and delete existing rendering sets and create
new rendering sets. Refer to Customizing Rendering Sets.

Before running a comparison

Before running a comparison, click E in the Compare Documents dialog.
) Rendering Sets — | X
Rendering Set. | Standard . Save || Savehs.. || Delete | Search Rendering Options
Comparison Options Comparison Options Redline Preview

Select the document features to be compared.
Redline Options

Redline Rendering A Comparison Options
Allow Auto Retry
Detect List Numbering Changes
Detect Footnote/Endnote Numbering Changes

Compare Headers/Footers

Compare Footnotes

El Compare at Character Level

El Compare Numbers at Character Level

(] Ignore Embedded Objects/Images

(] Ignore Case Changes

[T Ignore Text Boxes

[T ignore Field Codes

Compare field contents as text
[ ignore Tables

[[] Display comments in redline
[] Detect Changes to Images

O Ignore auto list against manual number list changes

| oK || Cancel || Help |

If you have permissions, you can modify and delete existing rendering sets and create
new rendering sets. Refer to Customizing Rendering Sets.

Additionally, you can edit the rendering set parameters as required and click OK. The
Save Rendering Set dialog is displayed where you can either:

e Enter the name of an existing rendering set to overwrite a rendering set or enter
a new name to create a new rendering set. Do not use the following characters
when naming rendering sets: <, >, :, \, “, /, \ or |. Click Yes. The updated
rendering set is saved and it is selected in the Compare Documents dialog.

e Click No. The revised options are saved as a temporary rendering set called
“Custom rendering set” and this rendering set is selected in the Compare
Documents dialog.
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After running a comparison

In the Workshare Compare main window, click Edit in the Home ribbon (Comparison
Themes group).

©) Rendering Sets — O *

Rendering Set: | Standard = Save Save As.. | | Delete Search Rendering Options

Comparison Options cOmpa rison Options Redline Preview
Select the document features to be compared.
Redline Options

Redline Rendering A Comparison Options
Allow Auto Retry
Detect List Numbering Changes
Detect Footnote/Endnote Numbering Changes

Compare Headers/Footers

Compare Footnotes

[[] compare at Character Level

O Compare Numbers at Character Level

[ Ignore Embedded Objects/Images

[[]Ignore Case Changes

O Ignore Text Boxes

[ ignore Field Codes

Compare fizld contents as text
[ Ignore Tables

| Display comments in redline
[[] Detect Changes to Images

[ Ignore auto list against manual number list changes

Apply | Cancel || Help

If you have permissions, you can modify and delete existing rendering sets and create
new rendering sets. Refer to Customizing Rendering Sets.

Additionally, you can re-run a comparison changing specific comparison options. Refer
to Changing the comparison options.
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Customizing Rendering Sets

If you have the relevant access rights, you can modify and delete existing rendering
sets as well as create new rendering sets.

Note: Depending on how Workshare Compare has been distributed through the
company, you may or may not have access rights to configure rendering sets. If you
have any questions about your access rights, please speak to your system
administrator.

Modifying existing rendering sets
If you have permission, you can modify the settings of an existing rendering set.
To modify an existing rendering set:

1. Inthe Rendering Sets Manager, select the rendering set you want to modify
from the Rendering Set dropdown list.

Rendering Set: [ Custom rendering set vJ

Custom rendering set
Standard no color
Standard no moves
Standard with caret for deletes
Redline Options | Standard with change numbers
Standard with font changes
Standard with shading
Standard

Comparison Opt

Redline Rendering

[ Allow Auto Retry

—_

2. Configure or modify the parameters for the rendering set as follows:

= Click a category in the left pane to display parameters for that category in
the right pane.

= Configure the parameters as required.
Categories and their parameters are described in Rendering Set Parameters.

3. Click Save. The modified settings are saved to the selected rendering set.

Creating new rendering sets

If you have permission, you can create a new rendering set. You create a new
rendering set based on an existing rendering set and then modify it as required.

To create a new rendering set:

1. Inthe Rendering Sets Manager, select the rendering set on which you want to
base your new rendering set from the Rendering Set dropdown list.
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2. Click Save As. The Save Rendering Set dialog is displayed:

(O Save Rendering Set X

Enter a name to use for the new rendering set.

Mew Set Name: " |

[}
=~

Cancel

3. Enter a name for the rendering set. Enter the name of an existing rendering set
to overwrite a rendering set or enter a new name to create a new rendering set.
Do not use the following characters when naming rendering sets: <, >, :, \, “, /, \
or |.

4. Click OK. The new rendering set is selected in the Rendering Set dropdown
list.

5. Configure or modify the parameters for the rendering set as follows:

o Click a category in the left pane to display parameters for that category in
the right pane.

= Configure the parameters as required.
Categories and their parameters are described in Rendering Set Parameters.

6. Click Save. The settings are saved to your new rendering set.

Deleting rendering sets

If you have permission, you can delete rendering sets from the Rendering Sets
Manager.

To delete arendering set:

1. Inthe Rendering Sets Manager, select the rendering set that you want to delete
from the Rendering Set dropdown list.

2. Click Delete. The selected rendering set is deleted.

Rendering Set Parameters

The parameters for rendering sets are grouped into the following categories:
e Comparison Options.
e Redline Options

¢ Redline Rendering
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The categories appear in the left pane of the Rendering Sets Manager. Selecting a
category displays the parameters for that category in the central pane. The right hand
pane show a preview of how the Redline will look with the parameters selected.

Comparison Options

Comparison Options Comparison Options
Select the document features to be compared.
Redline Options

Redline Rendering A Comparison Options

Allow Auto Retry

Detect List Mumbering Changes
Detect Footnote/Endnote Numbering Changes
Compare Headers/Footers

Compare Footnotes

[C] Campare at Character Level

[C] Compare Mumbers at Character Level
[ ignore Embeddad Objects/Tmages
[l ignere Case Changes

[l Ignore Text Boxes

[l Ignore Field Codes

Compare field contents as text

[ 1gnore Tables

[[] Display comments in redline

[[] Detect Changes to Images

[ 1gnore auts list against manual number list changes

-

The Comparison Options category includes parameters that enable you to customize
how the compare is performed.

The Comparison Options parameters are described in the following table:
Parameter Description

Allow Auto Retry When selected, if a comparison fails for any reason then
Workshare Compare automatically attempts to perform a
comparison using reduced settings. Workshare Compare
methodically and automatically disables the Comparison
Options selected until it is able to perform a comparison.
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Parameter

Detect List Numbering
Changes

Detect
Footnote/Endnote
Numbering Changes

Compare
Headers/Footers

Compare Footnotes

Compare at Character
Level

Compare Numbers at
Character Level

Ignore Embedded
Objects/Images

Ignore Case Changes

Ignore Text Boxes

Configuring Rendering Sets

Description

If selected, changes to automatically generated list
numbers for numbered paragraphs are detected.

If selected, changes to the numbering of footnotes and
endnotes are detected. You may want to deselect this
parameter yet keep the Compare Footnotes parameter
selected. This way, changes to the content of footnotes
and endnotes will be detected but not changes to the
numbering.

If selected, the headers and footers in the original and
modified documents are compared.

If selected, the footnotes in the original and modified
documents are compared.

If selected, words that are only slightly different from each
other are compared. For example, if banana has been
changed to bananas - Workshare Compare shows just an
insertion of an s in the Redline, rather than showing a
deletion of banana and an insertion of bananas. This is
intended to catch simple typing mistakes.

As above description, but compares numbers instead of
characters.

If selected, embedded objects and images are ignored
while doing the comparison and will not be displayed in
the Redline.

If not selected, the embedded objects and images will
appear in the Redline (although changes to them are not
detected unless the Detect changes to Images
parameter is selected.)

This option is useful when documents have very large
images embedded in them which would produce vast
amounts of data if written to the Redline RTF file and
would slow down the comparison process and the loading
of the Redline.

If selected, any case changes, for example, upper case to
lower case, made in the modified document are ignored.

If selected, any text boxes in the modified document are
ignored.
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Ignore Field Codes

Compare field
contents as text

Ignore Tables

Display comments in
Redline

Detect Changes to
Images

Ignore auto list
against manual
number list changes

Configuring Rendering Sets

Description

If selected, fields are treated as the same even if their field
codes differ. So if you have a Date field in the original
document and an Author field in the same place in the
modified document, the Redline will not show a change.

If not selected, field codes are compared and where they
have changed, the entire original field is shown as deleted
and the entire modified field is shown as inserted.

If selected, converts certain field codes to text and then
compares. If not selected, compares field code only.
Fields converted to text will not be subject to the Ignore
Field Codes parameter if that is also selected.

Note: The following field codes are converted to text:
TOC, REF, TOA, TA, DATE, TIME, COMMENTS,
KEYWORDS, AUTHOR, FILENAME, SAVEDATE,
CREATEDATE, PAGEREF, INDEX, DOCPROPERTY,
TITLE, MERGEFIELD, NOTEREF, SHAPE, QUOTE.
Other field codes will be dealt with according to the
Ignore Field Codes parameter setting.

For example, where there is a date field that in the original
document shows 1 Jan 2012 and in the modified updates
to 31 Jan 2012. When this parameter is selected, the
Redline will show 231 Jan 2012. Where this parameter is
not selected, no change will be shown.

If selected, any tables in the modified document are
ignored.

If selected, comments in the original and modified
documents are compared.

If selected, images in the original and modified documents
are compared.

In order for images to be compared, you must ensure that
the Ignore Embedded Objects/Images parameter is
NOT selected.

If selected, when an automatically formatted list is being
compared against a manual list, any changes in the
manual list are ignored.

Generally this parameter should NOT be selected. It
should only be selected in circumstances when one of the
documents being compared contains automatic list
numbering and the other document contains manual list
numbering.
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Redline Options

Comparison Options Redline Options
Set the options for the construction and display of the redline decument.

Redline Options

Redline Rendering A General Options

Include redline statistics At end of document ¥

[l Include Redline Comparnson Summary
[[] Include Redline Option Summary

[C] Display Warkshare Compare Footers
[C] Black And White Headers

[C] Black And White Footers

[C] show Moved Deletions

[C] Show Cha nges to Spaces

[C] Show Paragraph Changes

[#] Include file names in Redline statistics

A Change Indicator Options
[7] Show Hidden Text

[C] Show Line Numbering
[#] Show Change Numbering ToolTips

Show change bars [Left margin v|
Show change numbers [Ncrt shown = |
iA| Readability

Paragraph Matched Text Threshold

The Redline Options category includes parameters that enable you to customize how
the Redline is displayed and what information is included with the Redline.

The Redline Options parameters are described in the following table:
Parameter Description
General Options

Include Redline If selected, statistics about the changes between the

statistics original and modified documents is displayed in the
Redline. You can select to display these statistics at the
start of the document or at the end of the document.
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Include Redline
Comparison Summary

Include Redline Option
Summary

Display Workshare
Compare Footers

Black And White
Headers

Black And White
Footers

Show Moved Deletions

Show Changes to
Spaces

Show Paragraph
Changes

Include file names in
Redline statistics

Change Indicator
Options

Show Hidden Text

Show Line Numbering

Show Change
Numbering ToolTips

Show change bars

Configuring Rendering Sets

Description

If selected, a summary of all the changes is displayed at
the end of the Redline. The changes are hyperlinked to
take you directly to the change in the Redline.

If selected, a summary of the options selected in the
current rendering set is displayed at the end of the
Redline in the statistics report.

If selected, details about the two documents being
compared are displayed in the footer of the Redline.

If selected, changes detected in the header are rendered
in black and white. The color scheme set up in the
rendering set is maintained for changes to all other parts
of the document.

If selected, changes detected in the footer are rendered in
black and white. The color scheme set up in the rendering
set is maintained for changes to all other parts of the
document.

If selected, text that was deleted from a section of the
document and then subsequently moved to a new
location is indicated.

If selected, any extra spaces that have been added to or
deleted from the modified document are indicated.

If selected, paragraph markers (1) of any extra
paragraphs that have been added to or deleted from the
modified document are displayed.

If selected, the names of the compared documents are
included in the Redline statistics.

If selected, hidden text is displayed in the Redline.

If selected, the line number is displayed to the left of each
line in the margin of the Redline.

If selected, tool tips are displayed when you position the
cursor over change numbers.

If selected, vertical lines to indicate a change are
displayed next to each change in the margin of the
Redline. You can select to display the lines either in the
Left or Right margin.
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Parameter Description

Show change numbers  If selected, the change number is displayed next to each
change in the margin of the Redline. You can select to
display the number either in the Left or Right margin.

Readability See the Readability section below.

Note: The change indicator settings do not show if you open the Redline in Microsoft
Word.

Readability

The Readability option enables you to set at what point insertions and deletions should
no longer be marked individually but marked as an entire paragraph deleted followed by
an entire paragraph inserted. The deleted paragraph is as the paragraph appears in the
original document and the inserted paragraph is as the paragraph appears in the
modified document.

For example, the following paragraph showing numerous deletions and insertions is
quite difficult to read:

DeItaVlew RedqlmeJWMTable of Cen

It would be much easier to read this paragraph if it was presented as the entire
paragraph deleted followed by a new paragraph inserted, as follows:

Obviously, if there were only a few deletions and insertions in a paragraph, then the first
example is easy to read.
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With the Readability parameter, you can specify at what point Workshare Compare no
longer marks deletions and insertions individually but marks the entire paragraph as a
deletion followed by the new paragraph as an insertion. You specify this by setting a
readability percentage by dragging the Paragraph Matched Text Threshold slider to
your required setting. The percentage selected is shown in a tool tip above the slider.

A Readability

Paragraph Matched Text Thresheld D

10% |

The meaning of the setting is as follows:

e With readability set at 10%, Workshare Compare will mark insertions and
deletions individually unless 90% of the paragraph has changed. In other words,
in most circumstances paragraphs will be displayed in the same way as the first
example shown previously. Only when more than 90% of the paragraph has
changed will Workshare Compare display the paragraph as the second
example.

e With readability set at 50%, Workshare Compare will mark insertions and
deletions individually unless 50% of the paragraph has changed. In other words,
paragraphs will be displayed in the same way as the first example shown
previously unless more than 50% of the paragraph has changed.

e With readability set at 90%, Workshare Compare will mark insertions and
deletions individually unless 10% of the paragraph has changed. In other words,
in most circumstances paragraphs will be displayed in the same way as the
second example shown previously. Only when less than 10% of the paragraph
has changed will Workshare Compare display the paragraph as the first
example.

The default setting for readability is 10%.

Workshare Compare looks at each paragraph separately and assesses its readability
according to the number of changes in the paragraph.

Note: When working with tables, Workshare Compare does not treat the entire table
as a paragraph. Each paragraph within each cell is treated separately.

Readability only applies to paragraphs that contain both inserted and deleted text
because such paragraphs may be unclear whereas paragraphs with only insertions or
deletions do not have such readability problems.
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Redline Rendering

Comparison Options Redline Rendering

Set the options for how your changes are displayed/rendered in the redline
Redline Options document.,
Redline Rendering A Inserted Text

Inzerted Text Color - * |
Inserted Text Background w7 |

Inserted Text Format Double Underine "l

Surrounding Characters Change Text

v Deleted Text

¥ Moved Text

¥ Change Numbering
v Font Changes

v Style Changed Text

¥ Table Changes

The Redline Rendering category includes parameters that enable you to customize
how specific types of changes are displayed in the Redline.

The Redline Options parameters are presented in the following sections:

Inserted Text

The Inserted Text section includes parameters that enable you to customize how you
would like inserted text to appear in the Redline.

A Inserted Text

Inserted Text Color - ¥ |
Inserted Text Background * |

Inserted Text Format Double Underline - ]

Surrounding Characters Change Text
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The Inserted Text Format parameters are described in the following table:

Parameter Description

Inserted Text Color The color of inserted text.

Inserted Text The color of the background of inserted text.
Background

Inserted Text Format  The format of inserted text. Select from Underline, Double

Underline, Italic or Strikethrough.

Surrounding A keyboard character to go before and after inserted text.
Characters

Deleted Text
The Deleted Text section includes parameters that enable you to customize how you
would like deleted text to appear in the Redline.

A Deleted Text

Celeted Text Color - v|
Deleted Text Background - |

Celeted Text Format Srewathime g - ]

Surrounding Characters Change Text

Delated Text Replacemeant Character
[ Replace Deleted Text with a Single Character

[C] Include summary of deletions

The Deleted Text Format parameters are described in the following table:
Parameter Description

Deleted Text Color The color of deleted text.

Deleted Text The color of the background of deleted text.
Background

Deleted Text The format of deleted text. Select from Underline, Double
Format Underline, Italic or Strikethrough.

Surrounding A keyboard character to go before and after deleted text.
Characters
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Deleted Text
Replacement
Character

Replace Deleted
Text with a Single
Character

Include summary
of deletions

Moved Text

Configuring Rendering Sets

Description

The character used to replace deleted text. If the Replace
Deletes with Single Character checkbox is selected, the
deleted text is replaced with a single instance of the character
specified. If the Replace Deletes with Single Character
checkbox is not selected, each character in the deleted text is
replaced with the character specified. For example, if the word
compare is deleted and the character specified is X, the word
appears as XXXXXXX.

If selected, deleted text is replaced with a single character. If
you select this checkbox, enter the required character in the
Replacement Character field. For example, if the word
compare is deleted and the character specified is X, the word
appears as X.

If selected, a summary of deletions is included with the
Redline.

The Moved Text section includes parameters that enable you to customize how you
would like moved text to appear in the Redline.

Show Movements

Mowved Text Color

[ B

Moved Text Background - |

Moved Source Text Format [S.tnleet-h:eugh vl
MWowved Destination Text Format [Dguhlgjnﬁgdm v]
Mowe Source Surrcunding Characters Change Text

Maowe Destination Surrounding Characters Change Text
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The Moved Text parameters are described in the following table:

Parameter

Show Movements

Moved Text Color

Moved Text
Background

Moved Source Text
Format

Moved Destination
Text Format

Move Source
Surrounding
Characters

Move Destination
Surrounding
Characters

Change Numbering

Description

If selected, moved text is shown in the Redline. If you leave
this checkbox unchecked, then any text that has been
moved is displayed the same as inserted and deleted text.

Note: Text is only shown as moved if it's over 22
characters. Anything less will be shown as insertions and
deletions. This is to prevent showing moved text
incorrectly. For example, if someone had deleted the
word "and" from one paragraph and added "and" in
another, they probably have not moved the text, rather
they are just changing the individual paragraphs, so
would want them displayed as insertions and deletions.

The color of moved text.

The color of the background of moved text.

The format of the source moved text. Select the format of
the text in its original position from Underline, Double

Underline, Italic or Strikethrough.

The format of the destination moved text. Select the format
of the text in its new position from Underline, Double

Underline, Italic or Strikethrough.

A keyboard character to go before and after source moved
text. Specify the characters to surround the text in its
original position.

A keyboard character to go before and after destination
moved text. Specify the characters to surround the text in
its new position.

The Change Numbering section includes parameters that enable you to select
whether change numbers are shown in the Redline and, if so, how they appear.

A Change Numbering

[C] Show Change Numbering

Show Change Numbering before Change

Change Mumber Text Color

Change Mumber Text Format

Supersanipt
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The Change Numbering parameters are described in the following table:

Parameter Description

Show Change If selected, the number of the change is displayed next to each
Numbering change in the body of the Redline (as superscript).

Show Change If selected, the change number is displayed before the change. If
Numbering not selected, the change number is displayed after the change. It

before Change is recommended to position the change number before the
change as footnotes often appear after text. This reduces
confusion.

Change Number The color of change numbers.
Text Color

Change Number The format of change numbers. Select from a range of formats,
Text Format including Superscript or Bold.

Font Changes

The Font Changes section includes parameters that enable you to customize how you
would like any font changes to appear in the Redline.

A Font Changes

[] Show Fent Changes

Font Change Text Color - hd
Font Change Text Background T
Surrounding Characters Change Text

The Font Changes parameters are described in the following table:
Parameter Description

Show Font Changes If selected, font changes are shown in the Redline.

Font Change Text The color of font changes.

Color

Font Change Text The color of the background of font changes.
Background

Surrounding A keyboard character to go before and after font changes.
Characters

Note: Insertions and deletions override any font changes. For example, if the
modified document has new inserted text in a different font, it appears as inserted
text and not as font change text.
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Style Changed Text
The Style Changed Text section includes parameters that enable you to customize
how you would like any style changes to appear in the Redline.

A Style Changed Text

[ Show Paragraph Style Changes
Style Changed Label Color T

Show Character Style Changes

Style Changed Color i
Style Changed Background T
Style Changed Format Double Underline

Surrounding Characters Change Text

The Style Changed Text parameters are described in the following table:

Parameter Description

Show Paragraph If selected, paragraph style changes are shown in the

Style Changes Redline. Paragraph style changes are indicated in words, for
example, normal to heading two.

Style Changed The color of text in paragraphs where the paragraph style

Label Color has changed.

Show Character If selected, character style changes are shown in the

Style Changes Redline.

Style Changed The color of character style changes.

Color

Style Changed The color of the background of character style changes.

Background

Style Changed The format of character style changes. Select from

Format Underline, Double Underline, Italic or Strikethrough.

Surrounding A keyboard character to go before and after style changed

Characters text.

Note: Changes to heading styles are also shown in the statistics report at the end of
the Redline.
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The Table Changes section includes parameters that enable you to customize how you
would like any format changes in tables to appear in the Redline.

Table change options
Table Cell Inserted Coler
Table Cell Deleted Caolar
Table Cell Moved Color
Table Cell Merged Color
Table Cell Padding Color

| Changes with surrounding char: |
d

[

7

d

()

The Table Changes parameters are described in the following table:

Parameter

Table Change
Options

Table Cell Inserted
Color

Table Cell Deleted
Color

Table Cell Moved
Color

Table Cell Merged
Color

Table Cell Padding
Color

Description

The way changes in tables are indicated. You can select
from the following: Changes with surrounding
characters, Changes without surrounding characters,
Whole original and modified tables, Whole modified
table only or Whole modified table only (unmarked).

Selecting Whole modified table only (unmarked), the
modified table is shown in the Redline as a new table with
no changes marked. Selecting Whole modified table only,
the modified table is also shown in the Redline as a new
table but it is shown as an insertion.

The color of inserted cells.

The color of deleted cells.

The color of moved cells.

The color of merged cells.

The color of padded cells.
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What are padded cells?

Padded cells occur when an insert and delete have occurred within a table, a cell
becomes both an insert and a delete; therefore it creates a padded cell.

Original Table
Cell 1 Cell 2 Cell 3
Cell 4 Cell 5 Cell 6
Modified Table
Cell 1 Cell 3
Cell A Cell B
Cell 4 Cell 6
Rendered Table
Cell 1 Cell 2 Cell 3
Cell A PADDED CELL Cell B
Cell 4 Cell 5 Cell 6
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Appendix B. Configuring Comparison
Themes

This appendix describes how to configure comparison themes for Workshare Compare
for PowerPoint and apply them to a comparison. It includes the following sections:

e Introducing Comparison Themes, page 142, introduces Workshare Compare
comparison themes and describes how they determine the look of a
comparison.

e Applying Comparison Themes, page 142, describes how to apply a
comparison theme to a comparison.

e Customizing Comparison Themes, page 143, describes how to create your
own comparison themes as well as modify existing comparison themes.

e Comparison Theme Parameters, page 145, provides a detailed description of
all the comparison theme parameters.
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Introducing Comparison Themes

Workshare Compare for PowerPoint uses colors and different formats in the
comparison to enable you to see the changes that have been made to the presentation.

The colors and formats adopted depend on the comparison theme applied to the
comparison. Workshare Compare for PowerPoint includes a default comparison theme
that you can apply or you can modify this comparison theme or create your own
comparison theme.

Applying Comparison Themes

You can apply a comparison theme to a comparison before the comparison is run and
also at any time after a comparison has been performed.

To apply a comparison theme before the comparison is run:

In the Select Presentations for Comparison dialog, select a comparison theme from the
Select Comparison Theme dropdown list.

To apply a comparison theme after the comparison has been run:

In the Comparison Themes group of the Home tab, select a comparison theme from
the Select dropdown list. Workshare Compare for PowerPoint re-performs the
comparison applying the new comparison theme styles to the resulting comparison.
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Customizing Comparison Themes

You can maodify existing comparison themes as well as create new comparison themes.
Comparison themes are created and modified in the Comparison Themes Manager.

To open the Comparison Themes Manager:

Select Edit in the Comparison Themes group of the Home tab. The Comparison
Themes Manager is displayed.

Note: You can also click (2 to the right of the Select Comparison Theme field in the
Select Presentations for Comparison dialog.

@) Comparison Themes Manager — O et

View and edit existing comparison themes and create new ones

Detect All Changes ~ Create Mew Renarne Delete
Comparison Select the opticns to be included in the comparison
Insertions 4 Detect Changes to:

Deletions Speaker Motes

Moves Image Content

Property Changes Embedded Object Content

Font Changes ltem Location and Size

Text Formatting

Text Box Formatting

Slide Background

Hyperlink Target

Autoshape Style and Orientation
Detect Moved Text
Detect Moved Slides

Sensitivity

Apply oK Cancel

Comparison themes are made up of a set of parameters. The comparison theme
parameters are grouped into categories. The categories appear in the left pane of the
Comparison Themes Manager. Selecting a category displays the parameters for that
category in the right pane of the Comparison Themes Manager. The different
categories and their parameters are described in Comparison Theme Parameters.
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Creating new comparison themes

You can create new comparison themes as required to determine the colors and
formats used in the comparison to distinguish the changes that have been made to the
presentation.

To create a new comparison theme:

1. In the Comparison Themes Manager, click Create New. The Comparison
Theme Name dialog is displayed.

@ Comparisen Theme Mame >

Enter the new name for the comparison theme

|New Comparison Theme |

| oK | | Cancel

2. Enter a name for the comparison theme and click OK.

3. Inthe Comparison Themes Manager, specify the comparison theme parameters
as follows:
= Click a category in the left pane to display parameters for that category in
the right pane.
o Configure the parameters as required.

Categories and their parameters are described in Comparison Theme
Parameters.

4. Click Apply. The new comparison theme is saved.

Note: When you click OK in the Comparison Themes Manager, Workshare Compare
for PowerPoint re-performs the comparison applying the new comparison theme
styles to the resulting comparison.

Modifying existing comparison themes

You can modify existing comparison themes by changing the parameter settings for the
comparison theme or changing the name of the comparison theme. You can also delete
unwanted comparison themes.

To modify an existing comparison theme:

1. In the Comparison Themes Manager, select the comparison theme you want to
modify from the dropdown list.
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2. Modify the comparison theme parameters as follows:
= Click a category in the left pane to display parameters for that category in
the right pane.
= Configure the parameters as required.

Categories and their parameters are described in Comparison Theme
Parameters.

3. Click Apply.

Note: When you click OK in the Comparison Themes Manager, Workshare Compare
for PowerPoint re-performs the comparison applying the new comparison theme
styles to the resulting comparison.

To rename a comparison theme:

1. In the Comparison Themes Manager, select the comparison theme from the
dropdown list and click Rename. The Comparison Theme Name dialog is
displayed.

2. Enter the new name for the comparison theme and click OK. The comparison
theme is saved with the new name.
To delete a comparison theme:

In the Comparison Themes Manager, select the comparison theme that you want to
delete from the dropdown list and click Delete. The comparison theme is deleted.

Note: You can delete one of the predefined comparison themes but all predefined
comparison themes are regenerated when Workshare Compare for PowerPoint is
launched.

Comparison Theme Parameters

The comparison theme parameters for Workshare Compare for PowerPoint are
grouped into the following categories:

e Comparison

e Insertions

e Deletions

e Moves

e Property Changes
e Font Changes

e Sensitivity
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Comparison

The Comparison category includes parameters that enable you to specify what
changes Workshare Compare for PowerPoint will detect.

[Ccmpan'scn ] Select the options to be included in the comparison
Insertions 4 M| Detect Changes to:

Deletions Speaker Notes

Maoves o Image Content

Property Changes [C] Embedded Object Content

Fant Changes [_| Item Location and Size

Sensitivity [C] Text Farmatting

[C] Text Box Formatting

(] slide Background

[ Hyperlink Target

["] Autoshape Style and Qrientation
Detect Moved Text
Detect Moved Slides

The Comparison parameters are described in the following table:
Parameter Description

Detect Changes to Select the specific items that Workshare
Compare for PowerPoint will detect
changes to, from the following: Speaker
Notes, Image Content, Embedded
Object Content, Item Location and
Size, Text Formatting, Text Box
Formatting, Slide Background,
Hyperlink Target, Autoshape Style and
Orientation.

Detect Moved Text If selected, moved text within slides is
detected.

Detect Moved Slides If selected, moved slides are detected.
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The Insertions category includes parameters that enable you to specify how inserted
text as well as inserted images and objects will be displayed.

Comparison

Insertions ]

Deletions

Moves

Property Changes
Font Changes
Sensitivity

Select how insertions are highlighted

Insertion options Insertion sample
£ Bold
[ talic Inserted text

Underline

. —_r— ——— L]
[C] Strikethrough ' .‘q i :
I

o W) i (L]

The Insertions parameters are described in the following table:

Parameter

Insertion options

Description

Select how insertions are displayed.

You can select any or a combination of the following
formatting options for inserted text: Bold, Italic, Underline
and Strikethrough. (You cannot select Underline and
Strikethrough.) You also select the font color from the
Color dropdown list.

Inserted images and objects are indicated with a dashed
border in the selected color.

An example of how inserted text, inserted images and
inserted charts will look with your selections is shown.
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Deletions

The Deletions category includes parameters that enable you to specify how deleted
text as well as deleted images and objects will be displayed.

Comparison Select how deletions are highlighted

Insertions Deletion options Deletion sample
[Deletl'ons ] "] Bald

Maoves €] Halic Deleted text
Property Changes [C] Underline

Fent Changes Strikethrough i‘#"q i- .i
1 I
Sensitivity Colar: [T ﬁ j E _____ |

The Deletions parameters are described in the following table:
Parameter Description

Deletion options Select how deletions are displayed.

You can select any or a combination of the following
formatting options for deleted text: Bold, Italic, Underline
and Strikethrough. (You cannot select Underline and
Strikethrough.) You also select the font color from the
Color dropdown list.

Deleted images and objects are indicated with a dashed
border in the selected color.

An example of how deleted text, deleted images and
deleted charts will look with your selections is shown.
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Moves

The Moves category includes parameters that enable you to specify how moved text as
well as moved images and objects will be displayed.

Camparison Select how moved items are highlighted

Insertions Source (moved from)

Deletions Move source options Move source sample
Property Changes [ Htalic Sourcetfext
Font Changes [C] Underline

Sensitivity Strikethrough ?-“ i- ----- 'i

Destination (moved to)
Move destination options Move destination sample
[ old
[ ttalic Moved text

Underline

. —_——
[C] Strikethrough ! “ i i
Coor (M~ =

The Moves parameters are described in the following table:
Parameter Description

Move source options  Select how the source of moves is displayed.

You can select any or a combination of the following
formatting options for source moved text: Bold, Italic,
Underline and Strikethrough. (You cannot select
Underline and Strikethrough.) You also select the font
color from the Color dropdown list.

The source of moved images and objects is indicated with
a dashed border in the selected color.

An example of how source moved text, source moved
images and source moved charts will look with your
selections is shown.
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Parameter Description
Move destination Select how the destination of moves is displayed.
options You can select any or a combination of the following

formatting options for destination moved text: Bold, Italic,
Underline and Strikethrough. (You cannot select
Underline and Strikethrough.) You also select the font
color from the Color dropdown list.

The destination of moved images and objects is indicated
with a dashed border in the selected color.

An example of how destination moved text, destination
moved images and destination moved charts will look with
your selections is shown.

Property Changes

The Property Changes category includes parameters that enable you to specify how
items that have had their properties changed will be displayed.

Comparison Select how items with changed properties are highlighted

Insertions Changed items option Changed items sample

Deletions [ e i
oo WD i |

Mowves i i

[Prupert],r Changes ]

Font Changes
Sensitivity

The Property Changes parameters are described in the following table:

Parameter Description

Changed item option  Select a color from the Color dropdown list. Images and
objects that have had their properties changed are
indicated with a dashed border in the selected color.

An example of how changed images and charts will look
with your selection is shown.
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Font Changes

The Font Changes category includes parameters that enable you to specify how text
that has had its font changed will be displayed.

Comparison Select how font changes are displayed

Insertions
Changed font option Changed font sample

Color: W - Changed text

Deletions
Faoves

Property Changes

[Funt Changes ]

Sensitivity

The Font Changes parameters are described in the following table:

Parameter Description

Changed font option  Select a color from the Color dropdown mist. Text that has
had its font changed is displayed in the selected color.

An example of how changed text will look with your
selection is shown.
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Sensitivity

The Sensitivity category includes parameters that enable you to specify how sensitive
Workshare Compare for PowerPoint should be when detecting changes.

Comparisen Select the options for sensitivity of comparisons

Insertions Choosing extreme values for the sensitivity settings can lead to

Deletions unusual comparison results. The button to the right will reset all Reset All

values to their defaults.

M
o Slide similarity threshold (3]

Property Changes ﬂ

Font Changes

[ ] Text Box similarity threshald (%)
Sensitivity ﬂ

Table similarity threshold (%)

(]

Minimum length for moved text

0

Thresheold for detecting changes in size or position

Minimum ratio of unchanged text to surrounding changes

LA

The Sensitivity parameters are described in the following table:

Parameter Description
Slide similarity Specify at what point insertions and deletions should no
threshold (%) longer be marked individually but marked as an entire

slide deleted and an entire slide inserted.

For example, if you set the threshold at 30% and the
similarity between the slides is calculated to be less than
30% then they will be shown as an inserted and deleted
slide. If the similarity is calculated as more than 30% then
the slides will be shown with changes found to individual
items on the slides.

Drag the slider to your required setting. As you drag the
slider, the percentage is shown as a tool tip above the
slider.
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Parameter

Text Box similarity
threshold (%)

Table similarity
threshold (%)

Minimum length for
moved text

Threshold for detecting
changes in size or
position

Minimum ratio of
unchanged text to
surrounding changes

Configuring Comparison Themes

Description

Specify at what point insertions and deletions in text
boxes should no longer be marked individually but
marked as an entire text box deleted and an entire text
box inserted.

Drag the slider to your required setting. As you drag the
slider, the percentage is shown as a tool tip above the
slider.

Specify at what point insertions and deletions in tables
should no longer be marked individually but marked as
an entire table deleted and an entire table inserted.

Drag the slider to your required setting. As you drag the
slider, the percentage is shown as a tool tip above the
slider.

Specify the minimum number of characters to detect as a
move — moved pieces of text shorter than this threshold
will be shown as an insertion and a deletion.

Drag the slider to your required setting. As you drag the
slider, the length (in characters) is shown as a tool tip
above the slider.

Specify a threshold which determines how far an object
must be moved (or by how much its size must be
changed) for the change to be detected. The threshold
value is measured in inches.

Drag the slider to your required setting. As you drag the
slider, the position (in inches) is shown as a tool tip above
the slider.

Specify at what point short matches of text should be
ignored if they are surrounded on both sides by
unmatched text. This prevents common words such as
'of', 'and' and 'the' being matched up in a paragraph
where the content has been completely changed.

Drag the slider to your required setting. As you drag the
slider, the percentage is shown as a tool tip above the
slider.

Note: Selecting extreme values for the Sensitivity parameters can lead to unusual
comparison results. You can return the Sensitivity parameters to their default settings
at any time by clicking Reset All.
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Appendix C. Configuring Workshare
Desktop App

This appendix describes how to configure the Workshare desktop application (the
desktop app). This is an application that syncs content between Workshare and your
PC so you can access your files and continue collaborating from your desktop while
offline.
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Configuring the Workshare Desktop App

You can configure application settings for the Workshare desktop app, such as the
location of the sync folder or general account settings.

To configure the Workshare desktop app:

1. Click the desktop app system tray icon and select Preferences or from the File
menu in the desktop app main window, select Preferences. The following
dialog is displayed.

(=) Account — =

g u ‘« O ‘o
Account  Genmeral Metwork Sync Settings  Motifications

User Login: hsagal @yahoo.com
Sign out

Account:  hsagal@yahoo.com account
Server; https: ffmy.workshare.com

Wersion: Workshare 2.9.2590.0

Check for Updates

The Account page provides information about your account. You can see your
registered Workshare email address that you use to log in to Workshare as well
as the address to the Workshare server. Additionally, you have version
information about the desktop app.
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2. Select General.

5 General — >

Account  General MNetwork Sync Settings Motifications

Launch Warkshare when I login
Display DMS Open dialog when adding files (Requires Workshare 9 with a DMS integration)

Control how Woerkshare updates:
Automatically download and install updates -

3. Select the Launch Workshare when | login checkbox and the desktop app will
start when your computer is started.

4. When you have Workshare 9 with a DMS integration, select the Display DMS
Open dialog... checkbox and you can select files from your DMS when
uploading files to Workshare from the desktop app.

5. To control how Workshare updates, select from the dropdown:

= Automatically download and install updates: Updates to the desktop app
will be downloaded and installed automatically as they become available.

= Notify me when updates are ready to install: You will be notified when
updates to the desktop app are available.
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6. Select Network.

&) Metwork — *

@ u ‘| <O o
Account  General Metwork Sync Settings  Motifications

Bandwidth: Change Settings...

Proxies: Change Settings...

Metwork Status Connected

The Network page enables you to limit bandwidth settings and change the
settings of your proxy server.

7. Inthe Bandwidth field, click Change Settings.

=) Bandwidth Py

Download rate; Don't limit

Limit to: 0 KBS

Save Cancel

8. If you want to limit the bandwidth available to data downloaded to the desktop
app, deselect the Don’t limit checkbox and specify the limit in the Limit to field.

9. Click Save.
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10. In the Proxies field, click Change Settings.

=5 Proxy =

Proxy Settings: (O No Proxy
(®) Auto-detect

() Manual:
Farce Proxy:
Proxy Type: HTTP
Server:

Port:

Save Cancel

11. When working with a proxy server, select Auto-detect and Workshare will use
your computer’s system settings to connect to the network, or select Manual
and enter your proxy server details manually.

Note: There is no Auto-detect option available when working on a Mac.

12. When manually specifying proxy server settings, you can select Force Proxy so
that the desktop app traffic MUST go via your proxy server and if the proxy
server is not available then the desktop app will be offline.

13. Select the type of your proxy server (HTTP, HTTP Caching or Socks5) and
enter the server address and port number.

14. Click Save.
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15. Select Sync Settings.

=) Sync Settings — x

@ 8 @« © o

Account  General Metwork Sync Settings  Motifications

Workshare sync location;

| C:fUsers/helens \Warkshare Browse

Show sync conflict confirmation messages

16. If required, change the location of the Workshare sync folder by clicking the
browse button and selecting a different location. By default, this folder is named
and located as follows:

o Windows: C:\Users\[user name]\Workshare

o Mac: /Users/[user name]/Workshare

Any files or folders put in this folder will be synced to Workshare online and will
appear in the desktop app.

159



Configuring Workshare Desktop App

17. Select Notifications.

(=) Motification — x

Account  General Metwork SyncSettings  Motifications

Notify me when: By email By desktop alerts

Someone first accesses a folder
A new file is added to a folder
There is a new version of a file

A comment is posted

K EEIE
E K EIEIE]

When someone shares files or folders with me

18. If required, change the notification settings. By default, users receive
notifications by email and via desktop popup alerts in the following
circumstances:

o

o

o

When a user first accesses a folder you have shared with them
When a new file is added to a shared folder

When there is a new version of a file

When a comment is posted

When someone shares a file or folder with you
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